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Copyright Notice
Copyright © 2001 Magellan Corporation. All rights reserved.
No part of this publication or the computer programs described in it may be
reproduced, translated, stored in a retrieval system, or transmitted in any form or by
any means, electronic, mechanical photocopying, recording, or otherwise, without
prior written permission of Magellan. Your rights with regard to this publication and the
computer programs are subject to the restrictions and limitations imposed by the
copyright laws of the United States of America (“U.S.A.”) and/or the jurisdiction in
which you are located. For information on translations and distribution outside the
U.S.A. please contact Magellan.

Printed in the United States of America.
Part Number: 630821, Revision B
February, 2001

Trademark Notice
Ashtech is a registered trademark of Magellan Corporation. Mission Planning,
Download, GPS FieldMate, Seismark, Mine Surveyor, Z-12, Z-Xtreme, Real-Time Z,
Locus, Z-Surveyor, and Ashtech Solutions are trademarks of Magellan Corporation.
All other product and brand names are trademarks or registered trademarks of their
respective holders.
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SOFTWARE LICENSE AGREEMENT

IMPORTANT: BY OPENING THE SEALED DISK PACKAGE CONTAINING THE SOFTWARE MEDIA OR
INSTALLING THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS AND
CONDITIONS OF THE LICENSE AGREEMENT (“AGREEMENT”). THIS AGREEMENT CONSTITUTES
THE COMPLETE AGREEMENT BETWEEN YOU (“LICENSEE”) AND MAGELLAN. (“LICENSOR”).
CAREFULLY READ THE AGREEMENT AND IF YOU DO NOT AGREE WITH THE TERMS, RETURN
THIS UNOPENED DISK PACKAGE AND THE ACCOMPANYING ITEMS TO THE PLACE WHERE YOU
OBTAINED THEM FOR A FULL REFUND.

LICENSE. LICENSOR grants to you a limited, non-exclusive, non-transferable, personal license
(“License”) to (i) install and operate the copy of the computer program contained in this package
(“Program”) in machine acceptable form only on a single computer (one central processing unit and
associated monitor and keyboard) and (ii) make one archival copy of the Program for use with the same
computer. LICENSOR and its third-party suppliers retain all rights to the Program not expressly granted
in this Agreement.

OWNERSHIP OF PROGRAMS AND COPIES. This License is not a sale of the original Program or any
copies. LICENSOR and its third-party suppliers retain the ownership of the Program and all copyrights
and other proprietary rights therein, and all subsequent copies of the Program made by you, regardless of
the form in which the copies may exist. The Program and the accompanying manuals (“Documentation”)
are copyrighted works of authorship and contain valuable trade secret and confidential information
proprietary to LICENSOR and its third-party suppliers. You agree to exercise reasonable efforts to
protect the proprietary interests of LICENSOR and its third-party suppliers in the Program and
Documentation and maintain them in strict confidence.

USER RESTRICTIONS. The Program is provided for use in your internal commercial business
operations and must remain at all times upon a single computer owned or leased by you. You may
physically transfer the Program from one computer to another provided that the Program is operated only
on one computer at a time. You may not operate the Program in a time-sharing or service bureau
operation or rent, lease, sublease, sell, assign, pledge, transfer, transmit electronically or otherwise
dispose of the Program or Documentation, on a temporary or permanent basis, without the prior written
consent of LICENSOR. You agree not to translate, modify, adapt, disassemble, decompile, or reverse
engineer the Program, or create derivative works of the Program or Documentation or any portion
thereof.

TERMINATION. The License is effective until terminated. The License will terminate without notice from
LICENSOR if you fail to comply with any provisions of this Agreement. Upon termination, you must cease
all use of the Program and Documentation and return tem, and any copies thereof, to LICENSOR.

GENERAL. This Agreement shall be governed by and construed in accordance with the Laws of the
State of California and the United States without regard to conflict of laws provisions thereof and without
regard to the United Nations Convention on Contracts for the International Sale of Goods.
iii
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DISCLAIMER OF WARRANTIES AND LIMITATION OF LIABILITY

LICENSOR AND ITS THIRD-PARTY SUPPLIERS MAKE NO WARRANTIES OR
REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING THE PROGRAM, MEDIA,
DOCUMENTATION, RESULTS OR ACCURACY OF DATA AND HEREBY EXPRESSLY
DISCLAIM ANY WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE AND NONFRINGEMENT. LICENSOR AND ITS THIRD-PARTY SUPPLIERS DO
NOT WARRANT THE PROGRAM WILL MEET YOUR REQUIREMENTS OR THAT ITS
OPERATION WILL BE UNINTERRUPTED OR ERROR-FREE.

LICENSOR, its third-party suppliers, or anyone involved in the creation or deliver of the
Program or Documentation to you shall have no liability to you or any third-party for special,
incidental, indirect or consequential damages (including, but not limited to, loss of profits or
savings, downtime, damage to or replacement of equipment or property, or recover or
replacement of programs or data) arising from claims based in warranty, contract, tort
(including negligence), strict liability, or otherwise even if LICENSOR or its third-party suppliers
have been advised of the possibility of such claim or damages. The liability of LICENSOR and
its third-party suppliers for direct damages shall not exceed the actual amount paid for this
Program License.

Some states do not allow the exclusion of limitation of implied warranties or liability for
incidental or consequential damages, so the above limitations or exclusions may not apply to
you.

U.S. GOVERNMENT RESTRICTED RIGHTS
The Program and Documentation are provided with RESTRICTIVE RIGHTS. Use, duplication,
or disclosure by the Government is subject to restrictions as set forth in subdivision (c)(1)(ii) of
the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or
subdivision 9(C)(1) and (2) of the Commercial Computer Software - Restricted Rights 48 CFR
52.227.19, as applicable.
Should you have any questions concerning the Limited Warranties and Limitation of Liability,
please contact in writing: Magellan Corporation, 471 El Camino Real, Santa Clara, CA 95050,
USA.
iv Ashtech Solutions User’s Guide
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1

IntroductionIntroductionIntroductionIntroduction
What is Ashtech Solutions?

Ashtech Solutions is a state-of-the-art automatic post-processing software
package. It is extremely user-friendly, simplifying many of the office tasks, a
feature which will be appreciated by novice and experienced users alike. Ashtech
Solutions runs on Windows 95, 98, 2000, and NT 4.0 operating systems.

This powerful package includes components designed to assist you in all stages
of planning and post-processing a GPS survey:

• Mission planning
• Receiver setup
• Data transfer
• Vector processing
• Network adjustment
• Quality analysis
• Coordinate transformation
• Report generation
• Exporting

Ashtech Solutions integrates one of the fastest post-processing engines
available, as well as superior blunder detection to ensure proper processing the
first time. As the processing takes place, Ashtech Solutions continuously updates
a graphical display to provide a a true representation of your fieldwork.

Data presentation is optimized by use of a modified file system recently added to
Ashtech GPS receivers and data collection software. The new file system allows
Introduction 1
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entry of site ID, antenna height, and site descriptor for each point. The following
products use this modified file system:

• Receivers
• Z-Xtreme, firmware version ZA00 or later
• Z-Surveyor, firmware version UG00 or later
• Z-12 Receiver, firmware version 1M00 or later
• Real-Time Z, firmware version 6J00
• Locus, firmware version LA00 or later

• Handheld Software
• Pocket Survey Control v. 1.0 or later
• GPS FieldMate v. 3.0
• Mine Surveyor II, v. 3.0
• SeisMark II v. 3.0
• TDS Survey Pro with GPS v. 4.5.02 or later

Role of Ashtech Solutions in a GPS Survey

Once you have conducted your survey, Ashtech Solutions provides the ability to
accurately determine site locations within the parameters you establish. With the
post-processing completed, Ashtech Solutions allows you to perform blunder
detection, adjust your network, and review quality metrics.

Once the automatic processing is complete, Ashtech Solutions transforms your
raw data into a polished final report that can be produced in a variety of formats to
suit the client’s needs.

Where to Find Information

You can find information about Ashtech Solutions as follows:

• Ashtech Solutions - this manual
• Tutorial
• Help System - the Help system has additional information not found in this

manual including a comprehensive glossary.
2 Ashtech Solutions User’s Guide
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System Requirements

Ashtech Solutions has the following system requirements for your office personal
computer (PC).

• Pentium 90 MHz or faster. Ashtech Solutions runs on a slower Pentium or
an older 486, but productivity will be impaired.

• Windows 95, 98, 2000 or NT 4.0
• Minimum 35 MB hard drive space
• Minimum 2 MB RAM
• CD ROM
• Serial port to transfer data between PC and receiver/handheld

Installing Ashtech Solutions

To install Ashtech Solutions:

1. Start Windows or, if Windows is already running, close all applications.

2. Insert the CD in the CD ROM drive.

3. On most computers, the autorun utility starts automatically.

The Setup utility allows you to install Ashtech Solutions, install Adobe
Acrobat™, or explore the CD without installing. To install the software, click
on Install Ashtech Solutions. This starts the installation wizard which guides
you through the rest of the process.

4. If the Setup does not start automatically when inserting the CD-ROM, select
Run from the Start menu.

5. Type x:\setup and press Enter, where x is the letter designation for the CD
ROM drive. Ashtech Solutions installs itself after you agree to the terms of the
software license.

What Do I Do First?

If you are transitioning from standard surveying techniques to GPS, you may find
GPS technology baffling or even intimidating. However, once you become familiar
with the basic techniques, you will find that GPS is a powerful productivity tool.
The following scenario is recommended for users new to GPS.

1. Skim through all the Ashtech Solutions documentation, including the
readme.txt file installed with Ashtech Solutions, to familiarize yourself with
content and organization.
Introduction 3
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2. Following the instructions in the receiver manual, use the receiver to do an
actual miniature survey, such as a parking lot or park.

- OR -

Spend some time working through the examples in the tutorial to understand
the reasoning and terminology underlying the Ashtech Solutions.

3. Transfer your data to your PC, and run Ashtech Solutions software as
instructed in the Ashtech Solutions User’s Guide.

4. Print out your data in the format that you want.

Customer Support

If you have any problems or require further assistance, Ashtech Precision
Products Customer Support can be reached through telephone. e-mail or the
Internet.

Please refer to the documentation before contacting Customer Support. Many
common problems are identified within the documentation and suggestions are
offered for solving them.

Ashtech Precision Products Customer Support, Santa Clara, CA, USA

800 number: 800-229-2400

Direct dial: (408) 615-3980

Local voice line: (408) 615-5100

Fax line: (408) 615-5200

e-mail: support@ashtech.com

Ashtech Europe Ltd. Oxfordshire UK

Tel: +44 118 987 3454

Fax: +44 118 987 3427

Ashtech South America

Tel: +56 2 234 56 43

Fax: +56 2 234 56 47

When contacting customer support, please ensure the following information is
available:

• Receiver serial number
• Software version number
• Software key serial number
• Firmware version number
• A clear, concise description of the problem.
4 Ashtech Solutions User’s Guide
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2

Getting StartedGetting StartedGetting StartedGetting Started
This chapter describes the fundamentals of Ashtech Solutions, including starting
the software, navigating through the software, and using the various windows.

Starting Ashtech Solutions

To launch Ashtech Solutions from your Windows 95, 98, 2000, or Windows NT
desktop:

From the Start menu Programs folder, select Project Manager from the Ashtech
Solutions folder.

After the Ashtech Solutions screen appears momentarily, the Welcome dialog box
opens (Figure 2.1).

Use this dialog box to open an existing project, create a new project, open the last
project you worked on, or run Ashtech Solutions without a project.

Figure 2.1. Welcome Dialog Box
Getting Started 5



synergy.book Page 6 Wednesday, February 14, 2001 8:19 PM
Click the checkbox to disable Welcome dialog box when starting Ashtech
Solutions.

Quitting Ashtech Solutions

You can quit Ashtech Solutions at any time by selecting Exit from the Project
menu. If the project you are working on requires saving recent changes, a dialog
box appears prompting you to save the project.

Navigating Through the Software

The Ashtech Solutions main window has three windows to view and work with
your data: the Time View window, the Map View window, and the Workbook
window. All tasks necessary to successfully process and adjust your data can be
accomplished within these windows.

Using the Time View Window
The Time View window, Figure 2.2, displays the observations for each receiver
or file loaded into the project. This display provides a quick and easy look at the
observation time for each site.

The Time View title bar shows the date of data collection and indicates if the data
has been filtered. For more information on data filtering, see Chapter 5, Data
Processing.

When fully zoomed out, the Time View window displays one day of data at a
time. The Title Bar also shows which sequential day you are viewing.

Figure 2.2. Time View Window
6 Ashtech Solutions User’s Guide
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The left pane of the Time View window lists each receiver by serial number, and
the right pane displays each observation. Double-click a receiver to view
information about the receiver. If you collected data with a Locus receiver, but did
not use the handheld, the observations have site names ????. Before processing
data, you need to correct the site name for each observation.

Ashtech Solutions automatically uses different colors for each site in the project,
and every observation for a site appears in the same color for easy reference.
Above the right pane is the date and time scale.

Zooming

If you need to view a segment of observation data more closely, you can easily
zoom in on small segments in the Time View window.

To zoom in, click in the Time View window near the observation you want to zoom
in on, and drag the cursor to define the area to zoom in. When you release the
mouse key, the Time View window zooms in to the new area.

To zoom out, use the Esc key, or the Zoom Out button on the Toolbar to zoom out
one level. A second click on the Zoom Out button expands the view to its
maximum.

Tasks in the Time View Window

In the Time View window, you can complete the following tasks:

• View receiver information
• View raw data file information
• View and set observation information
• Include or exclude an observation in processing
• Print the time view
• Trim data from an observation
Getting Started 7
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Using the Map View Window
The Map View window, Figure 2.3, displays sites and vectors in the project, and
has several modes to highlight important attributes.

• Normal - Displays sites for data loaded into the project.
• Process - Displays processed sites, vectors between sites, and statistical

processing results. Unprocessed vectors are dashed lines, processed
vectors that passed the QA test are green, and processed vectors that
failed the QA test are red. Site and vector uncertainties are displayed as
error ellipses and a vertical error bar.

• Adjustment - Displays adjusted sites, vectors between sites, and
statistical adjustment results. Un-adjusted vectors are black lines,
adjusted vectors that passed the adjustment Tau test are green, and
adjusted vectors that failed the adjustment Tau test are red. Site and
vector uncertainties are displayed as error ellipses and a vertical error bar.

• Repeat Vector - Displays all vectors which have repeat observations and
the results of their comparison with each other. Vectors not repeated
display in black, repeated vectors whose comparison passes the QA test
are green, and repeat vectors whose comparison fails the QA test are red.

Repeat observations of the same site while collecting data in kinematic mode are all averaged into
one solution. No repeat vector is generated in these cases.

• Control Tie - Displays control points and the results of their comparison
between computed and published positions. Control points who

Figure 2.3. Map View Window
8 Ashtech Solutions User’s Guide
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comparison pass the QA test are green. Control points whose comparison
fails the QA test are red.

• Loop Closure - Displays all sites and vectors in the project. You can select
a loop of vectors in order to calculate a loop closure. Vectors are selected
one at a time until the loop is closed. Results of the loop are displayed.
Loops that pass the QA test are green. Loops that fail the QA test are red.

• Network Relative Accuracy- Displays adjusted sites, vectors between
sites, and the results of site pair relative accuracy computations. Relative
accuracy is computed for each site pair between which a vector has been
observed. Site pairs which pass the QA test are green. Site pairs that fail
the QA test are red.

Use the right-click menu to switch between views and change which elements are
displayed. The active tab in the Workbook window corresponds to the map view.

Legend, Colors and Symbols

Use the right-click menu to display a Legend (Figure 2.4).

General color scheme

The general color scheme for all map views:

• Green- Items which pass the QA check
• Red- Items which fail the QA check
• Orange- Selected Items

Figure 2.4. Map View Window Legend
Getting Started 9
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Site Symbols and Colors

Table 2.1 lists the symbol colors in all map views:

Vector Colors

Table 2.2 describes the vector symbols tied to a specific map view.

Table 2.1. Site Symbols

Unprocessed
(Brown; Magenta
when selected)

Processed (Blue;
Light Blue when

selected)

Adjusted (Teal;
Bright Green

when selected)

Failed (Red;
Magenta when

selected)

Site

Horizontal Control Site

Vertical Control Site

Horizontal and Vertical
Control Site

Table 2.2. Vector Colors

Map View Vector Colors

Unprocessed Black dashed lines

Processed Green- Processing QA pass
Red- Processing QA fail

Processed and
Selected

Bright Green- Processing QA pass
Magenta- Processing QA fail

Adjusted Green- Adjustment QA pass
Red- Adjustment QA fail
Black- Not adjusted

Control Tie Black

Repeat vector Red- Repeat vector analysis QA fail
Green- Repeat vector analysis QA pass
Black- Not a repeated vector

Loop closure Red- Loop closed and loop closure QA fail
Green- Loop closed and loop closure QA pass
Black- Vector not included in loop

Selected in any map Orange

Excluded Gray
10 Ashtech Solutions User’s Guide
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Error Displays

After you adjust the network, the vertical and horizontal error is displayed for each
point (Figure 2.5). Horizontal error is represented as an elliptical region around the
site, and estimates real error on the ground. Vertical error is represented as a bold
black line; the longer the line, the greater the error. When the Map View legend is
displayed, the sizes of these errors can be readily estimated.

Zooming

The Zoom feature allows you to view the map area in greater detail.

To zoom-in - Click and drag the cursor to define the area to zoom in. When you
release the mouse key, the Map View window zooms in to the new area.

To zoom-out - Use the Esc key or the Zoom Out button on the toolbar to zoom
out one level.

Tasks in the Map View Window

Use the Map View right mouse click to complete the following tasks:

• View a vector’s properties
• Include/exclude a vector in adjustment
• View a site’s properties
• Enter or edit a site name
• Set a control site to hold fixed for processing or adjustment, and edit its

coordinates
• Perform a loop closure test
• Print a map view
• View QA test results

Figure 2.5. Error in the Map View Window
Getting Started 11
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Using the Workbook Window
The Workbook window, Figure 2.6, has tabs to display different kinds of
information, from coordinates to network precision statistics. Several tabs have
editable fields.

Switch between displays by clicking a different tab.

Click on any column header to sort the data in ascending or descending order.

In many tabs, right-clicking on a value in a column displays the right-click menu
with different choices on how to view the information in that column.

Highlighting an item in a Workbook tab highlights the same item displayed in the
other views. For example, clicking on the Site ID of a particular site in the Site tab
highlights the site in the Map View.

Table 2.3 describes each tab and activities to do in the tab. See the Help system
for more information on the fields in the tabs

Figure 2.6. Workbook Window - Files Tab

Table 2.3. Workbook Window Tabs

Tab Name Description Activity

Files Information on the raw data files loaded into the
current project.

• Delete file from project
• View raw data for the file
• Select Antenna Type

Observations Information on each observation in the current project. • Edit Site ID
• Edit antenna height
• Select Antenna Type
• Select the antenna height type
12 Ashtech Solutions User’s Guide
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Message Window

Below the tabs is the Message Window, Figure 2.6, which displays summary
information, activity log information, and warnings. Although the text is not
editable, you can select text and copy to the clipboard or other applications by
right-clicking.

Sites Information on all sites including position,
uncertainties and whether the point is held fixed.

• View a site's properties
• Edit Site ID
• Delete a site from the project
• Enter or edit a site description

Control Sites Information on control sites with position, uncertainties
and whether the point is held fixed.

• Set a control site
• Edit a control site
• Enter or edit a site descriptor

Vectors Information on the most recently computed values for
all vectors after vector processing.

• Exclude a vector from
adjustment, reports, and export

• View raw data for the file
• View the residual data for the

vector
• Set the processing parameters

for a vector
• View the vector properties

Repeat
Vectors

Comparison information on any vector with repeat
observations.

• View only

Loop Closure Results of loop closure tests performed on vectors • Perform a Loop Closure test

Control Tie Comparison information on differences between
computed coordinates and entered known coordinates
for control points not held fixed

• View only

Adjustment
Analysis

Analysis of adjusted vectors after network adjustment. • Exclude a vector from
adjustment, reports, and export

• View raw data for the file
• View the residual data for the

vector
• Set the processing parameters

for a vector
• View the vector properties

Network Rel.
Accuracy

Analysis of adjusted network precision. • View only

Table 2.3. Workbook Window Tabs (continued)

Tab Name Description Activity
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The Ashtech Solutions Toolbar

The Toolbar provides easy access to frequently used commands. Table 2.4
describes each button on the Toolbar.

To display the Toolbar, select Toolbar from the View menu.

To choose a command from the Toolbar, click the button.

Table 2.4. Toolbar Buttons

Button Description

New Button - Click this button to create a new project file.

Open Button - Click this button to open an existing project file.

Save Button - Click this button to save the project.

Files from Receiver Button - Click this button to add data files to the project
directly from a receiver.

Files from Disk Button - Click this button to add data files to the project from a
hard or network drive.

Process New Button - Click this button to process only those sites and vectors
which have not been processed.

Adjustment Button - Click this button to adjust the network.

Workbook Button - Click this button to open or switch to the Files tab of the
Workbook window.

Time View Button - Click this button to open or switch to the Time View window.

Map View Button - Click this button to open or switch to the Map View window.

Zoom Out Button - Click this button to zoom out to the most recent zoom in the
active window.

Filter Button - Click this button to open the Filter dialog box and select the days
of data you wish to view in the project.
14 Ashtech Solutions User’s Guide
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The Ashtech Solutions Help System

Ashtech Solutions has an extensive Help system to assist you containing
additional information not found in this manual including:

• Context sensitive information for every dialog box
• Additional reference material, including some GPS background information
• Comprehensive glossary of most GPS terms used by Ashtech Solutions

and Ashtech receivers

You can access the Help system by pressing F1 from any window or dialog box in
Ashtech Solutions or by selecting Help Topics from the Help menu.

Project Settings Button - Click this button to open the Project Settings dialog
box.

Report Button- Click this button to generate a report of project data.

Export Button - Click this button to export project data to a file.

Table 2.4. Toolbar Buttons (continued)

Button Description
Getting Started 15
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3

ProjectsProjectsProjectsProjects
Ashtech Solutions uses a Project to manipulate data files and for processing site
locations. This chapter describes the creation, modification, and manipulation of a
project once you have collected survey data with a GPS receiver.

A project typically contains raw data files (received from GPS receivers) and site
information (site IDs, site names, and antenna heights) recorded in the handheld
or manually in a logbook.

Creating a Project

You may create a project anytime while the software is running or at startup.

To create a project with Ashtech Solutions running:

• Type Ctrl+N, or
• Click the New button on the toolbar, or
• Select New from the Project menu

This closes the current project and opens a new project. See Step 4 to continue
with the project setup.

To create a project at startup:

1. Start Ashtech Solutions.

A momentary screen opens, followed by the Welcome dialog box, Figure 3.1.
Projects 17
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2. Check the checkbox if you do not want this dialog box displayed during startup
in the future.

3. Click on Create a new project. The New Project dialog box opens, Figure 3.2.

Figure 3.1. Welcome Dialog Box

Figure 3.2. New Project Dialog Box
18 Ashtech Solutions User’s Guide
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4. The General tab allows you to enter project settings and administrative data.
Make the following entries:

• Project Name—Type a name for the new project, e.g. Smith Survey.

You must enter the project name in this field prior to entering a location because Ashtech Solutions
automatically creates a directory based on the project name.

• Location—This is the directory where the new project file is stored. If
the default directory is not the directory you want to use, enter the
directory you wish to use, or use the Browse button to select a
directory, after entering the project name.

5. Type in applicable administrative data in the remaining fields.

6. Click on Coordinate System to switch to the Coordinate System tab, Figure
3.3.

Use the Coordinate System tab to define the coordinate system. The
defaults, WGS-84, geodetic system, and ellipsoidal elevation appear the first
time you use the software. You can change these parameters to your
preferred settings, after which your preferred settings become the new
defaults. Refer to Chapter 9, Coordinate Transformations for more
information about coordinate system settings.

Figure 3.3. New Project Dialog Box — Coordinate System Tab
Projects 19
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7. Click Miscellaneous to switch to the Miscellaneous tab, Figure 3.4.

8. Set project parameters to the values you want to use. Table 3.1 describes the
components of this tab.

Figure 3.4. New Project Dialog Box — Miscellaneous Tab

Table 3.1. Miscellaneous Dialog Box Description

Component Description

Horizontal Enter your desired horizontal project accuracy for this
project in this field. Computed uncertainties of adjusted
data will be compared to this threshold value. Any data not
meeting this accuracy will be flagged in the QA field as
Failed. Default horizontal is 0.01m + 10 ppm

Vertical Enter your desired vertical project accuracy for this project
in this field. Computed uncertainties of adjusted data will
be compared to this threshold value. Any data not meeting
this accuracy will be flagged in the QA field as Failed.
Default vertical is 0.01m + 10 ppm

Confidence level Select the confidence level at which all point and vector
uncertainties will be calculated in the project. Your choices
are either 95% or Standard Error (68%).
20 Ashtech Solutions User’s Guide
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9. In the Time block, select the time system you are using, UTC or Local. If you
selected a Local time, type in the offset. This offset is the difference in hours

Linear units Click the arrow to the right of the field and select the linear
units for all input, displayed, and output of linear
information for the project. Available units systems: US
feet, International feet, or Meters.

Minimum vector time span The threshold value set in the Minimum Vector Time
Span field defines the minimum amount of overlap time
between observations before a vector is processed. If two
observations overlap by less than the threshold value, a
vector will not be generated. The suggested threshold
value is 5 minutes since any lesser amount of data almost
always results in a poor vector.

Valid antenna height range Enter the antenna height range, in the selected project
units, for any observation. Any antenna value outside this
range is considered a blunder and displays with a warning.

Time Select whether you wish time displays in the project to
display in UTC time or a Local Time. If you select Local
Time you must enter the offset in hours between the two
systems.

Processed vector error
scaling factor

A factor by which the uncertainties of the processed
vectors are scaled prior to adjustment. This is described in
more detail in Appendix C, Post-Adjustment Analysis.

Antenna Heights Click the arrow to the right of the field to select Slant or
Vertical as the default antenna height type. Any
observations read into the project that do not have a
defined antenna height type will be assigned the type
selected here. You can manually change the antenna
height type for each observation as necessary.

Table 3.1. Miscellaneous Dialog Box Description (continued)

Component Description
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between your local time and UTC. Use Figure 3.5 as a reference. For daylight
savings time, move one time zone to the east.

10. When you have finished setting up the project, click OK.

The Add Files dialog box opens, Figure 3.6. For information on adding files
to your project, refer to Chapter 4, Adding Data Files.

Figure 3.5. Offset from UTC

Figure 3.6. Add Files Dialog Box
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Opening an Existing Project

To open a previously created project:

1. In the Welcome dialog box, Figure 3.7, click on Open an Existing Project.

-OR-

• Type Ctrl+O
• Click the Open button on the tool bar
• Select Open from the Project menu

2. In the Open dialog box, Figure 3.8, navigate to the filename of the project you
wish to open. A project file has the extension .spr.

3. Double-click the filename, or highlight the filename and click Open.

Figure 3.7. Welcome Dialog Box

Figure 3.8. Open Dialog Box
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4. The project opens with the Time View, Map View, and Workbook windows.
Ashtech Solutions displays the project name in the title bar (Figure 3.9).

After opening a project, you may need to add data files. To add files, refer to
Chapter 4, Adding Data Files.

Saving a Project

You can save an open project at any time with one of the following methods:

• Type Ctrl+S
• Click the Save button on the toolbar
• Select Save from the Project menu

You can also save the current project with a different name. To save the project
under another name, select Save As from the Project menu.

If you used GPS Fieldmate, Seismark II, or Mine Surveyor II, a dialog box asks if
you wish to update the coordinates in the *.out file. Click Yes to overwrite the
coordinates in the *.out file. Click No if you do not want to update the coordinates
in the *.out file.

Figure 3.9. Typical Project
24 Ashtech Solutions User’s Guide



P
ro

jects

synergy.book Page 25 Wednesday, February 14, 2001 8:19 PM
Project Settings

The project settings are either the default or set when the project was created. To
view project settings select Settings from the Project menu or click the Project
Settings button on the toolbar.

The Project Settings dialog box (Figure 3.10) is the same as the New Project
dialog box. You can edit any of the parameters within the General, Coordinate
System, or Miscellaneous tabs. Once you have modified the parameters, click
OK to save the project settings and close the dialog box.

Deleting a Data File From a Project

Any raw GPS data file loaded into a project can later be deleted from the project.
All observations and vectors generated by these observations will be
automatically removed from the project.

To delete data files:

1. Switch to the Files tab in the Workbook window.

2. Select the file name of the files you wish to delete.

-OR-

Figure 3.10. Project Settings Dialog Box
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Press the Delete key or right-click and select Delete from the menu.

After deleting a data file, you must add the data file to the project again in order to use it.

Deleting a Site from the Project

Deleting a site from the project causes all vectors containing this site to be
deleted and the Site ID of all observations for this site to change to ????.

1. Select the site in the Sites tab of the Workbook window.

2. Select Delete from the right-click menu.

–OR–

Press the Delete key on your keyboard.
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4

Adding Data FilesAdding Data FilesAdding Data FilesAdding Data Files
This chapter describes the process for adding data files to a project. This process
uses the Download module of Ashtech Solutions. The following tasks are described:

• Add raw data files from receiver
• Add raw data files from disk
• Add site description data from handheld
• Add processed vectors which have been produced by another processing

package
• Remove data from project
• Set receiver parameters

You can add data files to your project when you first create the project, or later as
needed. Data files can be located on a hard drive (if previously downloaded from
the receiver) or can reside within a receiver.

If a project has already been created and you wish to add data files:

• Click F3 or select From Receiver...from the Project menu
• Click F4 or select From Disk...from the Project menu

Adding Data From a Receiver

You can add raw data directly from a GPS receiver and handheld by downloading
and adding data to a project in one, easy step by selecting Add raw data files from
receiver in the Project menu. Use this option to insert data directly from a handheld,
GPS receiver, or PC Card removed from the GPS receiver and inserted in a PC
Card reader.

If you have the option of removing the data card from the receiver to download the files using a PC
Card drive, you must still use Download to convert the files. If you only copy the files from the PC
Card without converting them, Ashtech Solutions will not be able to read and import them.
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synergy.book Page 28 Wednesday, February 14, 2001 8:19 PM
1. Connect the receiver to the PC as directed in your receiver manual, and verify
that the power is on.

2. Select Add raw data files from receiver from the Project menu. The
Ashtech Download main window appears (Figure 4.1).

The Ashtech Download main window consists of two panes. The right pane
(the PC pane) lists the files, if any, in the project directory of the PC. The left
pane (the Receiver or Handheld pane) lists the files in the receiver or
handheld.

The Receiver pane remains blank until the receiver establishes communication with the receiver or
handheld.

Table 4.1 describes the toolbar buttons.

Figure 4.1. Ashtech Download Main Window

Table 4.1. Ashtech Download Toolbar Button Descriptions

Button Description

Connect via Cable Button - Click this button to open the Connect via Cable
dialog box and connect to a receiver through a serial cable.

Connect via IR Button - Click this button to open the Connect via IR dialog
box and connect to a receiver through an IR device.

Switch Data Source Button - Click this button to open the Switch Data
Source dialog box and connect to another receiver or handheld.

Switch Pane Button - Click this button to change the active pane.

Session Info Button - Click this button to Open the Session Information
dialog box and set session parameters for the data file.
28 Ashtech Solutions User’s Guide
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3. Select Connect from the File menu.

If you are downloading data from a PC Card inserted in the PC Card reader of
you computer, select PC Drive and skip steps 4 to 7.

If you are downloading data from a receiver, select Receiver and then select
either Connect via Cable or Connect via IR depending on how the GPS
receiver is connected to your PC. Locus receivers are currently the only
receivers that connect via the IR port.

The Connect dialog box that opens depends on whether you connected by
the serial cable or IR device. Although the Select Port tabs are identical, the
Settings tabs vary.

Select Files Button - Click this button to select files based on a file mask. The
Select Files dialog box opens to enter a file mask for file selection.

Copy To Button - Click this button to copy the selected file(s) to the current
directory on the PC.

Move To Button - Click this button to move the selected file(s) to the current
directory on the PC.

Delete Button - Click this button to delete the selected file(s).

Create New Directory Button - Click this button to create a new directory in
the current PC directory.

Free Space Button - Click this button to check the available disk space for the
current drive or receiver.

Brief File Info Button - Click this button to display only the names of the files.

Detailed File Info Button - Click this button to display the name, size, date,
and time of last modification for each file and directory in the current directory.

Help Button - Click this button to access the help system.

What’s This Help Button - Click this button and anywhere else in the window
or menu system for quick help on the feature.

Table 4.1. Ashtech Download Toolbar Button Descriptions (continued)

Button Description
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4. In the Select Port tab, Figure 4.2, select the COM port the receiver or IR
device is using.

5. Switch to the Setting tab, Figure 4.3 and Figure 4.4.

6. Change the baud rate to the fastest rate the receiver supports to minimize the
download time.

Figure 4.2. Select Port Tab

Figure 4.3. Connect via Cable - Setting Tab

Figure 4.4. Connect via IR - Setting Tab
30 Ashtech Solutions User’s Guide



A
d

d
in

g
D

ata
F

iles

synergy.book Page 31 Wednesday, February 14, 2001 8:19 PM
7. Verify that the receiver is turned on and the IR ports are aligned, if using an IR
device, and click OK to connect to the receiver.

Download makes the connection and displays the contents of the receiver memory.

For example, the Receiver pane shown in Figure 4.5 lists:

• 0021a99.162—raw GPS data file, with “0021” as the site ID for all
receivers but Locus, or the Locus receiver serial number, “a” as the
session, “99” as the year, and “162” as the day of the year (other data
files may be listed)

• almanac—GPS satellite information file - use with Mission Planning
(refer to Appendix A, Mission Planning)

• iono corrections—GPS satellite ionosphere corrections file. The iono
corrections file is only created by a Locus receiver.

The almanac and iono correction files only contain complete information if the receiver has tracked
satellites for more than 15 minutes.

8. Verify that the destination directory in the PC pane is the project directory or
the directory where you want the data files to be stored.

If you want to create a new directory, click anywhere on the PC pane, then
click the New Directory button and type a name for the directory. Be sure to
use logical and consistent path and file naming conventions that are easy to
remember. Usually it is most convenient to put the data files in the project
directory.

9. Select the data file(s) that you want to download and drag them to the PC pane.
To select a group of contiguous files, hold the Shift key while selecting files. To
select particular files in the list, hold down the Ctrl key while selecting files.

10. Download copies the files to the PC. A progress dialog box indicates the
status of the download.

Figure 4.5. Ashtech Download Main Window
Adding Data Files 31



synergy.book Page 32 Wednesday, February 14, 2001 8:19 PM
Although the data files have been downloaded from the receiver, they have not
been deleted from the receiver’s memory. To delete receiver data files, select the
desired files and click the delete button on the toolbar. The Move function copies
and then deletes the files.

It is good practice to delete the data files in the receiver after verifying that the files
have downloaded properly. Otherwise, the memory may fill up during the next data
collection session, resulting in the inability to complete the survey.

Downloading Data From a Handheld

The manner in which data is imported from a handheld controller depends upon
the handheld software.

If you collected data using a handheld with TDS SurveyPro w/GPS, the information
is stored in the receiver, and when you download the data files from the receiver,
the site information collected using the handheld automatically downloads. You do
not need to download anything from the handheld.

If you collected data using a handheld with Seismark II, GPS FieldMate, or Mine
Surveyor II, refer to the software manual to download the *.out file. Download or
copy this file to the project directory. When you import the receiver data
corresponding to this *.out file into the project, Ashtech Solutions automatically
accesses the *.out file.

Downloading Data from an HP-48 Handheld
If you used an HP-48 handheld to collect site information download its data after
all receivers.

The receiver and handheld must be downloaded in the same download session for
the receiver and handheld data to be loaded correctly into the project. If receiver
files are downloaded separately from the handheld files, the handheld data will not
be associated with the receiver files. If this happens, delete the data files for the
project, and load them again using Add Raw Data Files From Disk.

1. With Ashtech Download running and connected to a receiver, select Switch
Data Source from the File menu.

Ashtech Download turns off the current receiver and prompts you to align a
different device.

2. Turn on the handheld and start its download program.

3. Align the IR ports within two inches of each other, and click OK (Figure 4.6).
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It is critical that the handheld be within 2 inches of the IR device for download. Also, take great care
to ensure that the IR device and the IR port on the handheld are aligned horizontally and vertically.
Since the IR device and the IR port of the handheld must be very close to each other, the horizontal
and vertical alignment are critical.

Ashtech Download automatically switches the baud rate to 2400 (the only
baud rate supported by the handheld), connects to the handheld, and lists the
one file in the handheld pane (D-file).

4. Select the D-file and drag it to the PC pane to copy the file to the PC.

Always transfer the D-file to the same directory as the raw GPS data files for a project.

5. Upon completion, the PC pane lists the D-file, and the handheld automatically
disconnects from the PC.

After download, it is good practice to delete the D-file from the handheld.

Downloading Data from Multiple Sources
If you have more than one receiver or handheld to download, use the Switch Data
Source function:

1. With Download running and connected to a receiver, select Switch Data
Source from the File menu.

Figure 4.6. Setup for Transferring HP-48 Handheld D-Files
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Download disconnects from the current receiver and opens the Switch Data
Source dialog box, Figure 4.7.

2. Connect the next receiver or handheld to the PC as specified in the receiver
or handheld manual, and verify that the power is on.

3. Click the button that corresponds to the manner in which the receiver or
handheld is connected, and click OK.

Download connects to the new receiver or handheld.

Ending the Download Process
Upon completing the download of all data files from the receiver(s) and handheld(s),
exit Ashtech Download by selecting Exit in the File menu.

If you entered Ashtech Download from Ashtech Solutions, verify that the Workbook
window lists all the data files you added to the project.

If a handheld was used during data collection and not downloaded with the receiver
data, the receiver data load into the project without attribute information. To recover
from this:

1. Delete the receiver data from the project file.

2. Download the handheld data into the same directory as the receiver data
files.

3. Load the data back into the project using selecting Add raw data from disk
from in the File menu.

Adding Data from Disk

Data files residing on your hard drive can easily be added to a project.

If your data files are stored on a PCMCIA card, use Ashtech Download to convert
the files before importing them into Ashtech Solutions. If you have the option of
removing the data card from the receiver to download the files from a PCMCIA
drive, you must still use Ashtech Download to convert the files. If you just copy the

Figure 4.7. Switch Data Source Dialog Box
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files from the PCMCIA card without converting them, Ashtech Solutions will not be
able to read and import them.

1. Select Add data from disk from the Project menu. The Add Files dialog box
opens (Figure 4.8).

2. In the Files of type combo box select a file type:

• Raw Data Files—Ashtech and RINEX format
• Ashtech Raw Files—Receiver-generated files (B*.*)
• RINEX Observation Files—Standard RINEX formatted files (*.*O)
• All Files (*.*)

3. Navigate to the data files you wish to add to the project.

4. Select and highlight all the data files you wish to add to the project.

Each highlighted file name appears in the File Name field.

5. Click Open.

Ashtech Solutions adds the files to the project.

The Files tab in the Workbook window lists all selected data files added to
the project.

Only B-files are shown in the Add Files dialog box. Upon clicking Open, associated D- and E-files
also load into the project.

Add Processed Vectors

You can add previously processed vectors (in Ashtech O-files) to your project.

These files may have been created by other Ashtech software packages or may
have been exported from other Ashtech Solutions projects.

Figure 4.8. Add Files Dialog Box
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1. Select Add Processed Vectors from the Project menu. The Add Vectors
dialog box opens (Figure 4.9):

2. Navigate to the directory where the vector files are stored. Ashtech Solutions
can import standard Ashtech binary O-files containing vector information.

3. Select the processed vector files you wish to add to your project and click OK.

Use the Vectors tab in the Workbook window to verify that the vectors have
been added to the project.

Removing Data From a Project

Any raw GPS data file loaded into a project can later be deleted from the project.
All observations and vectors generated by these observations will be automatically
removed from the project.

To remove data files:

1. Switch to the Files tab in the Workbook window.

2. Select the file name of the files you wish to delete.

3. Press the Delete key

-OR-

or select Delete from the right-click menu.

Once you delete a data file, you must add the data file to the project again in order to use it.

Figure 4.9. Add Vectors Dialog Box
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Recording Interval and Kinematic Warning 
Alarm

Use Ashtech Download to set the receiver recording interval and turn on or off the
kinematic warning flag on the Locus receiver.

1. Verify Ashtech Download is connected to a receiver.

2. Select Receiver Parameters from the Receiver menu. The Receiver Setup
dialog box opens.

3. Ashtech Download queries the receiver recording interval and displays it in
the Receiver Setup dialog box (Figure 4.10).

4. Enter the recording interval in seconds; the range of values is 0.5 to 999.

The recording interval is the time interval between recording data to memory.

Select ON to activate the kinematic warning flag, or OFF to deactivate this
flag. This option is only available for Locus receivers.

When the kinematic warning is set to ON, the kinematic warning alarm alerts
the Locus receiver operator, with a beeping sequence, when the Locus
receiver is not logging data from enough satellites to maintain the kinematic
initialization.

5. Click OK to send the parameters to the receiver and close the Receiver
Setup dialog box.

Figure 4.10. Receiver Setup Dialog Box
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5

Data ProcessingData ProcessingData ProcessingData Processing
Raw data collected by a receiver must be processed to determine the differential
relationship between the sites occupied during data collection. The result of
processing GPS raw data is a vector defining this relationship. Computation of
these vectors is the role of the data processing module within Ashtech Solutions.

The data processing module automatically analyzes the quality of the raw data
files and adjusts processing parameters to produce the best vector possible,
transferring most of the processing effort from the user to the processing software.
In Ashtech Solutions, the actual processing of your data is limited to a simple
press of the Process button, safe in the knowledge that you will get the best
answer.

GPS data is processed in three steps:

• Pre-process data analysis—Site and observation properties, such as
Site IDs, antenna height parameters, and control site information are
verified and/or entered.

• Processing—A push of a button invokes the processing engine to
produce GPS vectors from raw data.

• Post-process data analysis—Processed GPS vectors are analyzed
using supplied analysis tools, to determine the quality of processed data.

This chapter outlines the steps for processing your raw GPS data.

Pre-processing Data Analysis

The processing of GPS vectors relies on two sources of data, raw GPS data
collected by the receiver, and observation and site-specific data provided by the
user. When using a handheld or a GPS receiver with an integrated user interface,
much of the user-supplied data can be entered in the field during data collection.
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In this case, verify the data before processing. If a handheld was not used, this
data may be entered manually.

Verification and editing of user-supplied observation and site data can be
performed in more than one location within Ashtech Solutions. Primarily, the
Observation Property dialog box is used for this task. Table 5.1 outlines the
user-supplied data that can be viewed and edited in this dialog box.

You should analyze your data before processing. Pre-processing data helps you
through the preparation of data for baseline processing. You will also be able to
identify and correct common problems.

To begin the pre-process analysis:

1. If you have not done so already, load all the data files into your project. See
Chapter 4, Adding Data Files for more information.

2. Verify that the Time View window and the Workbook window with the
Observations tab are open (Figure 5.1).

In the Time View window, each horizontal band of color associates with a
different Site ID. All observations of a site are in the same color, e.g., each
observation of site PARK is green.

The Observations tab lists the associated antenna heights, start and stop
times, and file name for each observation.

Figure 5.1. Project Manager Main Window
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Filtering Data
Occasionally during data processing and adjustment it is beneficial to isolate a
segment of data for individual attention. Use the Filter function to isolate a
segment.

Data can be filtered by the day of collection. After filtering data, all subsequent
actions, including processing and adjustment, are performed only on the data
selected in the Filter dialog box. Data that have been filtered out are not visible
and no actions are taken on them.

For example, if three days of raw data were imported into a project and you wish
to work with only the data from one of these days, the other two days of data can
be filtered out.

To filter data:

1. Select Filter from the Edit menu

2. In the Filter dialog box, Figure 5.2, select the date(s) for the data you wish to
view.

Other days of data which you have not selected remain in the project but are
not visible.

3. Click OK to close the Filter dialog box and filter the data to the selected
date(s).

Time View provides another way to selectively view data. Time View shows one
day of data at any one time. You can easily switch to a different day by clicking on
the drop-down list in the top left of the window, and selecting a date. The Time
View changes to indicate the date. This only affects what is visible in the Time
View and does not affect any other views or actions such as processing or
adjustment.

Figure 5.2. Filter Dialog Box
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Editing Data
If you logged site information in the field using a handheld or integrated user-
interface on the receiver and have confirmed that Site IDs, observation time, and
antenna heights are correct, then you may not need to edit your data.

However, when viewing the data during the preprocess analysis, you may find
that you need to change some values. For example, if you conducted a static
survey without entering site information, you need to set the Site IDs and antenna
heights for every observation, or a site name entered incorrectly on the handheld.

Observation Properties

User-supplied observation data consists of the observation Site ID and antenna
height parameters. If this information was entered in the field using a handheld or
integrated user-interface to the receiver, verify the information is correct. If this
site information was not entered in the field, it needs to be entered manually prior
to processing.

Occasionally, observation start and stop times may need to be adjusted. For
example, during data collection of a kinematic survey, you may accidentally move
from a site while data was still being collected for the site. The end time of the site
observation would need to be modified to not include the time when the receiver
was moved off the site.

You can view the properties of each observation by double-clicking on the time
bar for an observation or by selecting Properties from the right-click menu of an
observation in the Time View window. In the Observation Properties dialog box,
Figure 5.3, you can change the Site ID and antenna parameters.

Figure 5.3. Observation Properties Dialog Box
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Table 5.1 describes the components of the Observation Properties dialog box.

You can edit any of these parameters except for the Raw Data File Name.
Although you can edit the start and stop times of an observation, there is one
exception to this; if the start or stop time of the observation coincides with the
beginning or end of a data file, you can not edit that time. Instead, insert a new

Table 5.1. Observation Properties Dialog Box

Parameter Description

Site ID A four-character alphanumeric identifier for the survey point. Each survey
point must have a unique Site ID. Otherwise, the processor has problems
determining which site each observation belongs to, causing inaccurate
positions.

Raw Data File Name Raw data binary file (known as a B-file), generated by the receiver,
containing carrier phase, code phase and computed receiver position for
every epoch, along with health flags indicating the confidence of the
measurements. The name of this file includes the Site ID or receiver serial
number, session letter, year, and day of the calendar year (B0014A98.273).

Antenna Height This field displays the antenna height in the units specified in the
Miscellaneous Tab of the Project Settings dialog box. You can set the
slant measurement for this observation, this file, or this receiver.

Height Type This field displays if the Antenna height is the Slant height or Vertical
height for the Observation.

Antenna Type This field displays the antenna model used to collect the data.

Observation Type The selected radio button corresponds to the data type for this observation.
• Select Static if this observation was collected while stationary over a

point.
• Select Kinematic if this observation was collected while moving. Data

collected using the Continuous Kinematic mode of data collection and
data collected while moving between points using the Stop&Go
Kinematic mode of data collection are both examples of observations of
a Kinematic observation type.

Start Time The time data started recording for the observation in either local time or
UTC Time. The Time Frame is specified in the Miscellaneous Tab of the
Project Settings property sheet.

Stop Time The time data stopped recording for the observation in either Local Time or
UTC Time. The Time Frame is specified in the Miscellaneous Tab of the
Project Settings property sheet.

OK Button Click the button to accept the parameters and close the dialog box.

Cancel Button Click this button to close the dialog box without saving the parameters.

Apply Button Not used.

Help Button Click this button to access the help system
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observation (see “Trimming Data” on page 54 for more information) and then edit
the times.

Site Properties

User supplied site data consist of Site ID, site descriptor, and, if available, known
site coordinates. If any sites occupied during data collection have known
coordinates, these should be entered as control sites for processing, for you
should begin processing with known coordinates at a minimum of one site. This is
referred to as the seed site for processing.

Ashtech Solutions can process raw data without a seed site. In such a case,
Ashtech Solutions selects one site to use as the control for processing. The raw
data coordinates for this site are used as the seed coordinates. In some cases
this may introduce error in the processed vectors in the amount of approximately
2-4 ppm of vector length. If this level of error is significant to your survey, a control
site must be used to process the data.

Kinematic data needs special attention when preparing the data for processing. If
the kinematic survey was initialized on a known vector, i.e. two known sites, the
coordinates for the sites on each end of this vector must be entered as control
sites. If initialization was performed using a Kinematic Initialization bar, the base
site should be identified as a control site. If this site does not have known
coordinates, use the raw data coordinates.

The Site Properties dialog box has three tabs to view and set site data. To open
the Site Properties dialog box for a site,

• Double-clicking on site in the Map View

-OR-

• Highlight a sight, and then select Properties from the right-click menu in
the Sites tab or Map View.
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General Tab

The General tab Figure 5.4, lists the site name, Site ID, solution type, and
whether the site is a control site and held fixed. You can edit the Site ID or Site
Descriptor by typing over the existing text.

Table 5.2 describes the components of the Site Properties dialog box, General
Tab.

oo95

Figure 5.4. Observation Parameters Dialog Box - General Tab

Table 5.2. Site Properties Dialog Box - General Tab Parameters

Parameter Description

Site ID A four-character alphanumeric identifier for a survey point. Each survey
point must have a unique Site ID. Otherwise, the processing will have
problems determining which point certain observations belong to. Site
name changes will modify any associated observation’s site name.

Site Descriptor 20-character alphanumeric name or description for the Site ID to identify
the site.

Solution Type • Raw—the position derived from a raw GPS data file collected at the site
• Processed—the position derived from the processing of the vector(s)

including this site
• Adjusted— the position derived from the adjustment of vectors including

this site

Control Type Indicates if the site is a control site for the project in either the horizontal
or vertical directions or both.
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Position Tab

The Position tab (Figure 5.5) lists the position coordinates and position
uncertainty for the site.

To view the site coordinates in a different coordinate system, click the arrow to the
right of the System field, and select a coordinate system from the list presented.

Only the system type selected in the Coordinate System tab, and the types below it, are available.

Table 5.3 describes the components of the Position tab.

Fix Status Indicates if the position is fixed vertically or horizontally.

Kinematic Initialization point
using Initialization Bar

Flag indicating this site is the Rover-initialized site on a kinematic
initialization bar.

Figure 5.5. Site Properties Dialog Box - Position Tab

Table 5.3. Site Properties Dialog Box - Position Tab Parameters

Parameter Description

System Geodetic/Grid/Local Grid - Selection available depends on the system type
chosen in the Coordinate System tab of the Project Settings dialog box.

Latitude/Easting The latitude or the easting (x) of the point

Table 5.2. Site Properties Dialog Box - General Tab Parameters (continued)

Parameter Description
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Control Tab

The Control tab (Figure 5.6) is used to set the site as a control point, hold the site
fixed, and enter the control site coordinates.

Longitude/Northing The longitude or the northing (y) of the point

Ellips Height The ellipsoidal height of the point, if available.

Orthometric Height The orthometric height of the point, if available.

Conf. Level The statisically derived confidence level of each component of the position.

Convergence The grid convergence angle for the site. A convergence angle displays only
when a Grid or Local system is selected.

Scale Factor If using a grid system, this is the factor used to convert ellipsoidal distances
to grid distances. It varies from point to point over the projection area.

Elevation Factor Elevation factor is a scale adjustment applied to distance measurements in
order to reduce the distances to the ellipsoid surface. This is the first step to
converting measured distances to grid distances. After the measured
distance is reduced to an ellipsoidal distance, it is scaled again by the scale
factor to produce a grid distance.

Figure 5.6. Site Properties Dialog Box - Control Tab

Table 5.3. Site Properties Dialog Box - Position Tab Parameters (continued)

Parameter Description
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Table 5.4 describes the components of the Control tab.

Using Sites in Processing

Including

All sites are automatically included when you process the data.

Removing

To remove a site from processing you must delete it. Select the site in the Map
View window and select Delete from the right-click menu to completely remove
the site from the project file.

Deleting a site only deletes the point object. The raw data associated with the site
remains in the project, and the Site ID is changed to ????. To reestablish the site,
edit the observation Site IDs to the old ID.

Using Observations in Processing

Including

All observations without the Site ID of ???? are automatically included when you
process the data.

Table 5.4. Site Properties Dialog Box - Control Tab Parameters

Parameter Description

System Geodetic/Grid/Local Grid - Selection available depends on the
system type chosen in the Coordinate System Tab of project settings.

Latitude/Easting The latitude or the easting (x) for the point

Longitude/Northing The longitude or the northing (y) for the point.

Ellips Height The ellipsoidal height of the point, if available

Orthometric Height The orthometric height of the point, if available.

Conf. Level This is the statistically derived confidence level of each component.

Control Type Check the box corresponding to the type of control: horizontal and/or
vertical. If neither box is checked, none of the fields in Coordinate,
Uncertainty, or Fix Status are accessible.
After selecting a control type, enter the control coordinates for the
site.

Fix Status Check these boxes to indicate that the position is fixed vertically and/
or horizontally.
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Removing

You may want to remove an observation from processing because you know the
observation was conducted at the wrong survey point, the data was bad, or the
receiver lost lock to the satellites. Ashtech Solutions will not process the vectors
associated with an excluded observation.

To remove an observation, rename the Site ID to ????. Refer to “Editing Site ID”
on page 50.

Set a Control Site

When processing GPS raw data collected simultaneously within a network,
coordinates of one or more points should be held fixed. Normally, these are the
known coordinates for one of the points. These coordinates are called seed
coordinates and the site a control site. You should always choose a site with
known coordinates as your control site. If you are not concerned about the control
site, Ashtech Solutions automatically chooses a site and sets it as the control site.

The coordinates for known control points can be entered for use as the seed point
in vector processing and as fixed control for the adjustment. Control points can be
used as horizontal control only, vertical control only, or both. You have the option
of entering a control point but not holding the control values fixed. The advantages
of this capability are:

• You can enter all known control points at any time. You may chose to enter
all control at the very start of the project. You would select just one point to
hold fixed horizontally and one vertically (can be the same point) for
processing and the minimally constrained (free) adjustment. When it
becomes time to perform the fully constrained adjustment, you simply
need to inform the software to hold fixed the other control points.

• You can perform a Control Tie Analysis. You enter all control prior to the
minimally constrained adjustment but hold fixed only one horizontally and
one vertically. The Control Tie tab of the Workbook will then display the
comparisons between the known control values and the adjusted values
for those control points you entered values for but did not hold fixed. A
large deviation may indicate a problem with the control.

Set a control site from the Workbook window

1. Click on the Control Sites tab of the Workbook window.

There may not be any control sites listed yet in this tab.

2. Click on the arrow on the right side of the Site ID box and select a control site.

3. Enter the known Easting/Latitude, Northing/Longitude, and Orthometric/
Ellipsoidal Height coordinates for the control site unless you wish to use the
raw data coordinates (NAV position).
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Ashtech Solutions automatically sets the site as a vertical and horizontal fixed
control site.

4. If you wish the point to be held fixed in either the vertical or horizontal
direction, click the arrow in the Fixed field and select the type of fix for the
point.

5. Unless known, set the Std. Err. of each value to zero (0).

After setting a control site, the symbol for that site in the Map View window
becomes a circle with a triangle inside it.

Set a Control Site in the Site Properties Dialog Box

1. From the Map View window, double-click on a site to open the Site
Properties dialog box.

2. Switch to the Control Tab.

3. Check the Control Type and Fix Status boxes corresponding to the type of
control and position fixing for the site.

4. Select the Coordinate System, and enter the known position coordinates for
the control site.

5. Click OK to save any changes and close the Site Properties dialog box.

Editing Site ID

The Site ID is a very important property of a site. Each site must have a unique
Site ID. A site cannot exist unless there exists an observation associated with it.
When an observation is entered into the project with a specific Site ID, a site is
created. The Site ID of any existing site can be edited to a different ID.
Observations with this Site ID are automatically changed to the new ID. There
may be times when you want to change the Site ID—such as when you want to
remove observation from being processed, rename a Site ID from ????, or modify
an incorrect Site ID.

You can edit a Site ID in a number of different ways:

• Click on the Sites tab in the Workbook window and double-click (or right-
click) on the Site ID and modify the name.

• Double-click (or right-click) on the observation bar of a site in the Time
View window to open the Observation Parameters dialog box and
double-click (or right-click) on the Site ID and modify the name.

• Double-click (or right-click) on the site within the Map View window to
open the Site Properties dialog box and then double-click (or right-click)
on the Site ID and modify the name.

Changing the Site ID in the Site Properties sheet has a different effect than
changing it in the Observation Properties sheet. In the Site Properties sheet, a
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change in the Site ID changes all observations containing this Site ID to the new
value. In the Observation Properties sheet, a change of the Site ID only affects
that particular observation.

Editing Antenna Parameters

Invalid antenna parameters are a major cause of blunders during processing
including, but not limited to: transposing numbers when writing down the antenna
height, reading the height incorrectly, or occupying the wrong point.

If incorrect data (or no data) were entered into the data files, Ashtech Solutions
provides the opportunity to modify these measurements to ensure valid and
reliable processing of the data.

To determine if antenna parameters were incorrectly entered via the handheld, review the field notes
from the survey(s).

To verify the antenna parameters:

1. Double-click on the observation bar for and observation in the Time View
window to open the Observation Parameters dialog box.

2. If the Antenna Parameters are missing or incorrect, enter the correct antenna
parameters, and indicate if the value should be used only for the selected
observation, all observations for the file, or all observations for the receiver.

You can also edit antenna parameters in the Observation tab of the Workbook
window.

Antenna Height

The three elements defining the location of the GPS data collection point are
Antenna Height, Height Type, and Antenna Type. The Antenna Height and Height
Type are inseparably tied together.

The Antenna Height is one of three elements that define the vertical offset
between the location of the GPS data collection point and the feature being
surveyed (survey mark, topo ground shot, etc). The processing software requires
this information to report the elevation of the surveyed feature.

If the selected Height Type is Slant, then the Antenna Height is the measured
distance between the feature being surveyed and the Slant Height Measurement
Point of the antenna (edge of antenna or ground plane).

If the Height Type is Vertical, then the Antenna Height is the measured distance
between the feature being surveyed and the Antenna Reference Point (ARP). The
ARP is the very bottom of the antenna.
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With this information and a selected Antenna Type, the Ashtech Solutions
automatically determines the location of the GPS data collection point and
compute elevation values of the surveyed feature.

Antenna Type

The Antenna Type is one of three elements that define the vertical offset between
the location of the GPS data collection point and the feature being surveyed
(survey mark, topo ground shot, etc). The other two elements are Antenna Height
and Height Type. To proper determine the elevation of the feature being
surveyed, the correct Antenna Type must be selected for each observation.

With the properly Antenna Type selected, along with the Antenna Height and
Height Type, the Ashtech Solutions automatically determines the location of the
GPS data collection point and compute elevation values of the surveyed feature.

You can select the antenna used for an observation in the following locations:

• Files Tab of the Workbook window
• Observations Tab of the Workbook window
• Receiver Information dialog box
• Observation Properties dialog box

Creating a New Antenna Type

You can create a new Antenna to add to the list of Antenna Types in either the
Receiver Information dialog box or the Observation Properties dialog box.

To create a new antenna from the Receiver Information dialog box:

1. Double-click a receiver in the Time View window to open the Receiver
Information dialog box.

2. Click the arrow to the right of the Antenna Type field, and select Unknown
from the list presented.

3. Click the Define button to open the Antenna Parameters dialog box
(Figure 5.7).

Figure 5.7. Antenna Parameters Dialog Box
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4. Enter the name for the new antenna in the Antenna Name field.

5. Enter the radius, in meters, in the Antenna Radius field.

6. In the Slant Height Measurement Point Vertical Offset field, enter the
vertical offset from the Antenna Reference Point (ARP) to the Slant Height
Measurement Point (SHMP) of this antenna. The units are in meters. If the
SHMP is above the ARP, the offset value is positive. This is the case for most
antennae.

7. In the L1 Phase Center Vertical Offset field, enter the vertical offset from the
Antenna Reference Point (ARP) to the L1 Phase Center. The units are in
meters. If the L1 Phase Center is above the ARP, the offset value is positive.
This is the case for most antennae.

8. If the new antenna is an L1 and L2 antenna, enter the vertical offset from the
Antenna Reference Point (ARP) to the L2 Phase Center in the L2 Phase
Center Vertical offset field. If the L2 Phase Center is above the ARP, the
offset value is positive. This is the case for most antennae.

9. Click Apply to add the antenna to the List of Antenna Types, and close the
Antenna Parameters dialog box.

The antenna you just added to the list of Antenna Types is the selected
Antenna Type in the Receiver Information dialog box.

To create a new antenna from the Observation Properties dialog box:

1. Select an observation in the Time View window or in the Observation tab of
the Workbook window.

2. Select Properties from the right-click menu top open the Observation
Properties dialog box.

3. Click the arrow to the right of the Antenna Type field, and select Unknown
from the list presented.

4. Click the Define button to open the Antenna Parameters dialog box
(Figure 5.7).

Figure 5.8. Antenna Parameters Dialog Box
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5. Enter the name for the new antenna in the Antenna Name field.

6. Enter the radius, in meters, in the Antenna Radius field.

7. In the Slant Height Measurement Point Vertical Offset field, enter the
vertical offset from the Antenna Reference Point (ARP) to the Slant Height
Measurement Point (SHMP) of this antenna. The units are in meters. If the
SHMP is above the ARP, the offset value is positive. This is the case for most
antennae.

8. In the L1 Phase Center Vertical Offset field, enter the vertical offset from the
Antenna Reference Point (ARP) to the L1 Phase Center. The units are in
meters. If the L1 Phase Center is above the ARP, the offset value is positive.
This is the case for most antennae.

9. If the new antenna is an L1 and L2 antenna, enter the vertical offset from the
Antenna Reference Point (ARP) to the L2 Phase Center in the L2 Phase
Center Vertical offset field. If the L2 Phase Center is above the ARP, the
offset value is positive. This is the case for most antennae.

10. Click Apply to add the antenna to the List of Antenna Types, and close the
Antenna Parameters dialog box.

The antenna you just added to the list of Antenna Types is the selected
Antenna Type in the Observation Properties dialog box.

Trimming Data

The Trim Data function is useful to cut off and not use the first or last couple of
minutes of data in an observation for processing, or rename the beginning or end
of an observation to a different Site ID. Trim Data inserts an observation at the
start or end of the data file. This observation fills the space left open by the editing
of the start or stop time of the observation that previous occupied this time period.

To trim data from the beginning of an observation, select an existing observation,
and select Trim Before from the right-click menu. Select a new site name, or use
???? to trim the data. Enter the End Time for the trimmed data, and click OK.

To trim data from the end of an observation, select an existing observation, and
select Insert After from the right-click menu. Select a new site name, or use
???? to trim the data. Enter the Trim Time for the trimmed data, and click OK.

Consider an example. Assume you have an observation at the end of a data file
which ends at 08:15:00. For some reason, you want to stop this observation at
08:10:00. Since this observation continues to the end of the data file, you can not
edit the end time unless you insert a filler observation in its place. Using the Trim
Data feature, an observation can be inserted at the end of the file that begins at
08:10:00 and ends at 08:15:00. You can give this observation a Site ID of ????
so that it will be ignored during processing.
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Adding Kinematic Data Points to the Data Set

Observations with a Site ID of ???? are normally associated with periods of time
when the user is moving. Most commonly, observations with a Site ID of ???? are
found between point observation in data collected using the Stop&Go Kinematic
mode. Although this data is used in the processing of the Stop&Go Kinematic
data, the results from the observation with a Site ID of ???? are not reported
anywhere.

It’s possible to make use of the observations with a Site ID of ???? by assigning
Site IDs to selected data samples with the observation. Each Site ID is assigned
to only one data sample. The result is a set of points outlining the trail followed by
the user during the time period of the ???? observation.

1. Right-click the observation with the Site ID ???? in either the Time View
window or the Observations Tab of the Workbook window.

2. Select Properties from the right-click menu to open the Observation
Properties dialog box.

3. Verify that the Kinematic radio button is selected as the Observation Type.

4. Enter a valid Site ID in the Site ID drop down list box.

Ashtech Solutions will automatically increment the Site ID to fill the
observation; be sure to enter a Site ID that will not overlap existing Site IDs in
the project.

5. Click OK to open the Adding Points dialog box(Figure 5.7).

6. Enter a description for the series of points.

7. Enter the time in seconds corresponding to the sampling interval you wish.

For example, if you enter 5, Ashtech Solutions will assign a Site ID to a one
second data point (one epoch of data) every five seconds.

8. Click OK to create the data points and close the Adding Points dialog box.

If you entered a Site ID which will generate one or more points with Site IDs
that will overlap an existing point, the Point Conflict dialog box opens asking

Figure 5.9. Antenna Parameters Dialog Box
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you to select a different starting point. Select the suggested Point ID or enter
a different Site ID, and click OK.

9. Verify the new set of points in the Observations Tab of the Workbook
window or in the Time View window.

The Adding Points dialog box can also be accessed from the Observation Tab
in the Workbook window by editing the Site ID of an observation whose current
ID is ????. Once the new ID is entered, the Adding Points dialog box opens.
From this point, follow sets 6 through 9 above.

Processing Data

Processing data is simple. After selecting either Process All or Process
Unprocessed, Ashtech Solutions processes the data and continues until it is
done, all the while updating the Time View, Map View, and Workbook windows
with processed data information.

Ashtech Solutions requires the hardware key to process L1/L2 and/or GLONASS data. Before
processing data, verify that the hardware key is connected to the LPT1 parallel port on your
computer.

Processing comprises the following steps:

1. Prior to beginning the actual processing, Ashtech Solutions verifies that you
selected a seed site. If not, Ashtech Solutions displays a message similar to
Figure 5.10.

2. If you wish to select your own seed site, click No and select a control site in
the Control Sites tab.

3. If the specified site is acceptable, click Yes and Ashtech Solutions processes
the data using the specified seed site.

Figure 5.10. Seed Coordinate Message Dialog Box
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Process All
To process all data within the project, select Processing All from the Run menu.

If any vectors already exist, Ashtech Solutions displays a message indicating that they will be over-
written.

Process Unprocessed
To process only data that have not been previously processed or have changed,
select Unprocessed from the Run menu or click on Process New button.

Post-Processing Data Analysis

The primary product of processing GPS raw data between two sites is a vector
defining the relationship between these sites. Site coordinates are by-products of
the processed vector. When a vector is processed, the coordinates of one site are
always held fixed. From the processed vector, coordinates are determined for the
unknown site. Prior to adjustment, the site coordinates are derived exclusively
from the processed vectors to this site. For sites with multiple vectors, the
displayed coordinates are derived from the vector with the lowest uncertainties.
Adjustment of the data results in more accurate and reliable site coordinates.

Ashtech Solutions has indicators to help determine the quality of processed
vectors and computed site coordinates. The quality indicators for processed
vectors includes a process QA flag, solution type, and vector uncertainties. Quality
indicators for computed site coordinates are site position uncertainties and a
position status flag.

The vector uncertainties give an estimate of the quality of the processed vector.
Experience helps to determine what level of uncertainties can be expected for
varying vector lengths. In general, the uncertainties should be similar to the
accuracy specifications of the receiver. Also, vectors of similar lengths should
have similar uncertainty values. Notice that the amount of data available for
processing a vector has an effect on the vector uncertainty. If too little data is
available, the uncertainty values will increase. Refer to your receiver manual to
obtain guidelines about the amount of data required for obtaining good results.

The solution type is an indication of the success of determining the integer
ambiguities for each satellite in the calculation of a vector. If all integer ambiguities
were determined, the vector solution is considered a Fixed solution (ambiguities
Fixed to integers). A Fixed solution is the best possible solution. If integer
ambiguities were determined for only a subset of the satellite (over 50 percent),
the solution is considered a Partial solution. A vector with a solution type of Partial
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in many cases is still a quality vector. For instance, on longer vectors (20 km or
longer), it is, in many cases, not practical to expect to get a Fixed solution
because of the increased noise in the solution due to the length of the vector.
Finally, a vector with a solution type Float indicates that less than 50 percent of
the integer ambiguities were determined. In most cases, a vector with a solution
type of Float will be poor in quality. Only very long baselines (80 km or longer)
should have a vector with a Float solution type. If you have a float solution on a
shorter vector, there is probably a problem with the data used to produce this
vector.

The process QA flag examines the magnitude of the vector uncertainties to
determine the quality of the processed vector. The magnitude of the vector
uncertainties is compared to a threshold value. If the uncertainties are greater
than the threshold, the QA test fails and the vector is flagged. The threshold value
has been selected based on the expected accuracy for vectors collected and
processed in the receiver. It is important to remember that a flagged vector does
not indicate conclusively that the vector is bad. The QA test is designed to warn
you of potential problems with a vector. Include flagged vectors in the adjustment.
The analysis tools in the adjustment provide additional means to determine if the
vector is indeed problematic. If so, it can be eliminated.

The site uncertainties estimate the quality of the computed site position. The
uncertainties are derived directly from the vector uncertainties for a site. If multiple
vectors exist for a site, the site adopts the uncertainties from the last processed
vector. An adjustment on the data improves the site coordinates and reduces
uncertainties.

The position status flag gives an indication of how the coordinates for the site
have been derived. Flag settings are Raw, Processed, and Adjusted. Each
represents a different level of reliability and accuracy, with Raw being the least
reliable and accurate, and Adjusted being the most reliable.

The quality indicators discussed here are presented in different ways within
Ashtech Solutions, depending on the view used for analysis. The remainder of
this section shows how to analyze these indicators in graphical and tabular form.
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Graphical Review
Once Ashtech Solutions has processed the raw GPS data, the Map View window
changes from Normal to Process (Figure 5.11).

The sites from the raw data have been processed displaying various visual
information.

• Horizontal Control—a triangle is placed over each site which has
horizontal control

• Vertical Control—a circle is placed over each vector which has vertical
control

• Horizontal and Vertical Control—the ASH site has a triangle and a circle
indicating it has horizontal and vertical control

• New Sites—new sites are represented by blue squares
• Error Regions—graphical display of the horizontal uncertainties of the

vectors.
• Vertical Error Bar—graphical display of the vertical uncertainties of the

vectors.
• Vectors—a solid line represents each processed vector. If the vector

passes the QA test and has a solution type of Fixed, the line is green. If the
vector fails the test or has a solution type of Partial or Float, the vector is
red.

If Ashtech Solutions encounters errors during processing, the Map View window
displays these errors.

Figure 5.11. Map View - Process
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Workbook Review
To review the data in the Workbook window:

Vectors

Click the Vectors tab in the Workbook window.

• Vector uncertainties are presented in tabular form at the confidence level
and in the units set in the Miscellaneous tab of the Project Settings
dialog box. An uncertainty is presented for each vector component in
addition to an uncertainty for the entire vector.

• A tabular column includes the results of the QA test for each vector. If a
tabular cell for a given vector is empty, the vector passed the QA test. This
indicates that the computed vector uncertainties fall below the threshold
value, the vector fails the test, and Failed is displayed.

• A tabular column indicates the solution type for each vector. If the solution
type for a specified vector is Fixed, the tabular cell is blank. In the solution
type is Partial, the cell displays the word Partial. Finally, if the solution type
is Float, the cell displays Float.

Delta ENU values are always local topocentric values even when a grid or local grid system is
current.

Sites

Click the Sites tab in the Workbook window.

• Site uncertainties are presented in tabular form at the confidence level and
in the units set in the Miscellaneous tab of the Project Settings dialog
box. An uncertainty displays for each position component.

• A tabular column displays the position status. If the displayed position is
derived from the raw data collected at the site, the position status column
displays the word Raw. If the displayed position is derived from processing
of vectors to this site, the column displays Processed. If the displayed
position is derived from an adjustment of all vectors to this site, the column
displays Adjusted.
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Message Window

If processing was successful, the following messages are displayed:
Processing started.
Processing Summary:
Number of vector processed: 9 of 9.

Anticipate that the number of vectors processed is equal to the number you
expected to process. In the above example, if only 7 of 9 vectors were processed,
you know that a problem exists.

Manually Processing Vectors

When Ashtech Solutions automatically processed GPS vectors, it must make a
number of decisions to produce the best possible vector solution from the data it is
presented. On occasion, an automatically processed vector will result in a poor
quality solution. In some cases, the poor solution is simply due to insufficient or
overall poor data. Nothing can be done to improve a solution in this situation. But
here are cases where a poor solution is due a segment of poor data, i.e. one
satellite or all data below a certain elevation angle. In these cases, it is sometimes
possible to eliminate the problem data and reprocess to produce a good quality
vector.

Ashtech Solutions includes tools to allow the user to analyze raw data used to
produce a vector and analyze the residuals of a processed vector in an effort to
isolate the problem data causing the poor vector solution. Once the problem data
is identified, Ashtech Solutions allows you to remove this data and reprocess the
vector in hopes of producing a good quality solution. This section of the manual
explains these tools in detail.

Viewing Residual Data for a Vector
To assist in isolating the cause of a problem with a processed vector, the residuals
from the least-squares solution of the vector processing can be viewed and
analyzed. If, through analysis of the residuals, a problem is identified with a
segment of the data or a specific satellite, the problem data can be removed and
the vector re-processed in hopes of a better result.

You can access the Vector Processing Residual Plot for a specific vector by
right-clicking on the vector name (From – To) in the Vectors tab of the Workbook
window. Select View Residuals from the right-click menu.

The Vector Processing Residual Plot displays vector processing residuals
(double-difference phase residuals) over time. There is one plot for the data from
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each satellite used in the processing of the vector with the exception of the
reference satellite. The following data is plotted for each satellite:

• L1 double-difference phase residuals
• L2 double-difference phase residuals (if available)

Only the data used in vector processing are displayed. Any data eliminated from
the processing by certain processing settings are not displayed. For example, if
the raw data file contains satellite data down to a 10° elevation but the vector was
processed with a 15° elevation mask, the residual plots does not show the data
below 15° because it was not used in processing this vector.

When processing a vector using data from raw data files containing multiple
observations (such as a data file collected in kinematic mode), all data from the
data files are used during in the processing. For this reason, the Vector
Processing Residual Plot (Figure 5.12), for such a vector, displays residuals for
the entire time span covered by the two files used to process this vector, including
the data associated with other observations. The segment of the residual plot that
pertains specifically to the vector selected is marked by two vertical dashed lines.

You can right-click anywhere within a plot to access the right-click menu to select
which elements to display.

Click on a plotted line to display the satellite pair generating the residuals plotted.

Click each tab to display residuals for available satellites.

The following characteristics of problem satellite data can cause poor results
when processed:

• Gaps in the data caused by extended loss of lock of the satellite. This is
characteristic of an obstructed satellite. If all satellite plots have gaps

Figure 5.12. Vector Processing Residual Plot
62 Ashtech Solutions User’s Guide



D
ata

P
ro

cessin
g

synergy.book Page 63 Wednesday, February 14, 2001 8:19 PM
during the same time periods, the missing data may be with the reference
satellite.

• A satellite with residuals noticeably larger than other satellites. This is a
characteristic of a satellite affected by multipath and/or an active
ionosphere. If all satellite plots have residuals that seem larger than
normal, the problem may be with the reference satellite.

• A segment of a satellite with residuals noticeably larger than the rest of the
same satellite. This is characteristic of a segment of satellite data affected
by multipath and/or an active ionosphere. If all satellite plots have a
segment with residuals that are larger than the rest or the residuals, the
problem may be with the reference satellite.

• A satellite with a sloped residual plot. Residual plots should not be sloped
and should have a mean value of 0 cycles. A sloped plot usually indicates
a problem with the satellite data. If all plots are sloped, this usually
indicates that the reference satellite is a problem.

• A satellite contributing a very small amount of data compared to the other
satellites in the data set. Sometimes such a satellite causes problems with
processing.

You can remove any data exhibiting the above characteristics and reprocess the
vector. Refer to “Setting the Processing Parameters for a Vector” on page 65 for
more information.

The residual data are stored outside the project file in files named P*.* for each
processed vector. If the corresponding file is not located in the project folder,
residual information will not display.

Viewing Raw Data for an Observation
Analyzing the raw data used to produce a vector is another good method of
isolating a problem with a vector. If, through analysis of the raw observation data,
a problem is identified with a segment of the data or a specific satellite, the
problem data can be removed and the vector re-processed in hopes of a better
result.

A Raw Measurement Plot can be accessed by one of the following methods:

1. Right-click a raw data file name in the Files Tab of the Workbook window,
and select View Raw Data from the right-click menu.

-or-

2. Right-click a vector name in the Vectors Tab of the Workbook window and
select View Raw Data from the right-click menu. Select the raw data file name
containing the observation data used to produce this vector from the second
menu.
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The Raw Measurement Plot (Figure 5.13) displays satellite data collected over
time. There is one plot for each satellite observed and a plot compiling all
satellites. For each satellite observed, the following data is plotted:

• L1 Carrier Phase
• L1 Signal-to-Noise Ratio
• L2 Carrier Phase (if available)
• L2 Signal-to-Noise Ratio (if available)
• Elevation

m

Figure 5.13. Raw Measurement Plots
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In addition to the satellite data, the Carrier Phase Plot and the Signal-to-Noise
Plot displays flags assigned to the data by the GPS receiver during data
collection. The following lists the flags along with their symbols:

X – Loss of satellite lock

! – Possible loss of satellite lock

? – Questionable carrier phase

± – Polarity unknown

You can right-click anywhere within a plot to access the right-click menu to select
which elements to display.

Click on a plotted line to display the satellite ID for the selected line. This is
especially useful when viewing the plot containing all of the satellites.

Click on a flag to display the satellite ID and a description of the type of flag.

Click each tab to display a plot of the data for each satellite observed.

The following characteristics of problem satellite data can cause poor results
when processed:

• Segments of satellite data that contain multiple flags. This is characteristic
of an obstructed satellite.

• Gaps in the data caused by extended loss of lock of the satellite. This is
characteristic of an obstructed satellite.

• A satellite with rapidly varying signal-to-noise ratio compared to other
satellites. This is characteristic of a satellite affected by multipath or an
active ionosphere.

• A segment of a satellite with rapidly varying signal-to-noise ratio compared
to the rest of the same satellite data. This is characteristic of a segment of
a satellite affected by multipath or an active ionosphere.

• A satellite contributing a very small amount of data compared to the other
satellites in the data set. Sometimes such a satellite causes problems with
processing.

You can remove any data exhibiting the above characteristics and reprocess the
vector. Refer to “Setting the Processing Parameters for a Vector” on page 65 for
more information.

Setting the Processing Parameters for a Vector
On occasion, processing produces vectors that fail the QA test and/or may
produce uncertainties that are larger than expected. Through analysis of the
Vector Processing Residual Plot for a problem vector and Raw Measurement
Plot for both raw data files used in processing of a problem vector, the specific
data segments causing the problem can be identified in many cases. By utilizing
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the tools found in the Process Settings dialog box, this data can be eliminated
and the problem vector re-processed in hopes of obtaining better results.

1. Select the vector in the Vectors tab of the Workbook window by clicking on
the vector name (From – To).

2. Select Process from the right-click menu to open the Process Settings
dialog box to the General tab (Figure 5.14.

The General tab has many of the most common elements of data you may
wish to edit out when processing.

3. If analysis of the data plots reveals problems at the start or end of the data
used in processing the vector, change the start or end time to eliminate this
data.

4. To change the start or end time, enter the new time in the time system
selected for the project.

5. Click the Reset button to reset the observation to the start and end times in
the raw data files. The times will reset even after the data has been
reprocessed.

6. If analysis of the data plots reveals that all data from one or more satellites is
problematic, the data from the problem satellite(s) can be omitted.

Figure 5.14. Process Settings Dialog Box — General Tab
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To omit one or more satellites from processing, enter the satellite numbers,
separated by commas, in the Omit these SV’s: field. You can retrieve the
satellite number from the Raw Data Plots.

7. If analysis of the data plots reveals a reference satellite as being problematic,
this satellite can be forbidden from use as a reference.

To specify one or more satellites to not use as a reference satellite, enter the
satellite numbers, separated by commas, in the Forbidden reference SV’s:
field. You can retrieve the satellite number from the Raw Data Plots.

8. If analysis of the data plots reveals that data below a certain elevation is
problematic, this data can be omitted.

To omit data below a specific elevation, enter this elevation in the Elevation
mask angle: field.

If analysis of the data plots reveals a segment of data for one or more satellites as
being problematic, you can eliminate this data using the Advanced tab in the
Process Settings dialog box.

1. Select the vector in the Vectors tab of the Workbook window by clicking on
the vector name.

2. Select Process from the right-click menu to open the Process Settings
dialog box to the General tab.

3. Click on the Advanced tab to switch to the Advanced tab (Figure 5.15).

Figure 5.15. Process Settings Dialog Box — General Tab
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4. Enter the time in HH:MM:SS you want to start the data exclusion in the first
row of the Start Time column.

5. Enter the time in HH:MM:SS you want to finish the data exclusion in the first
row of End Time column.

6. Enter the satellite numbers, separated by commas, in the first row of the SV’s
column. The satellite number can be retrieved from the data plots.

7. Enter the same data in the next row for each additional period of data you
wish to exclude from processing.

8. Click OK to save the settings and reprocess the vector.

If analysis of the data plots reveals that the same problem data on multiple
vectors, it is possible to eliminate this data from all affected vectors at once by
selecting multiple vectors prior to entering the Process Settings dialog box.
Follow the same steps outlined above for eliminating the problem data.

When editing processing settings for a vector generated from data files containing
multiple observations, such as a data file collected in Kinematic mode, all vectors
computed from the same data files will be affected. Therefore, if multiple problem
vectors exist that were computed from the same data files, there is no need to
select all the problem vectors to edit the processing settings. Change the settings
for just one vector and reprocess. All vectors from the same data files will be
automatically reprocessed with the new settings.

When editing Process Settings for multiple vectors, it is not possible to edit the Start and End times.

Special Considerations for Processing 
Stop&Go and Continuous Kinematic Data

The processing of GPS data collected in Static mode is rather straight forward
with the required steps discussed earlier in this chapter. Processing of GPS data
collected in stop&go kinematic and continuous kinematic modes require some
additional steps that will be outlined here.

Control Points for Kinematic Initialization
The processing of data collected in kinematic mode is successful only if the
kinematic survey was properly initialized at the start of the survey and each time
initialization is lost due to an insufficient number of satellites. To initialize a
kinematic survey, the post-processing software must be able to precisely
establish the coordinates of one of the points observed by the rover receiver
(initialization point) during kinematic data collection. Alternatively, the precise
coordinates of one of the points observed by the rover (initialization point) can be
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supplied to the processing software. In this case, the coordinates of the
initialization point must be precisely known relative to the coordinates of the base
point. There are a number of different methods to accomplish this. Each method is
handled differently by the processing software. Let’s examine each initialization
method in detail and discuss the additional steps, with regard to control points,
required to prepare the post-processing software to process the data.

• Static Survey Initialization

One method to determine the precise coordinates of a rover point is to
perform a static survey on the first point observed by the rover. By
observing this first point in static mode for the required period of time, the
processing software will be able to compute the position of this point. This
supplies the required point for initialization of the remainder of the
kinematic survey.

Processing of kinematic data with initialized by first performing a static
survey requires no special steps compared to static processing. If you
know the coordinates of the kinematic base station and want to hold them
fixed, enter them in the Control Sites tab. Otherwise, the software will use
an approximate position for the base station and hold it fixed for
processing automatically. The software will first determine the position of
the initialization point and then determine the position of the remaining
kinematic points.

• Bar Point Initialization

The concept of the initializer bar initialization is similar to using a static
survey to initialize your kinematic survey. By performing a 5 minute
observation on the bar, you are establishing the coordinates of the rover
receiver on the other end of the bar. Once the coordinates of the rover
location are established, the kinematic survey can be initialized. A 5
minute observation is all that is needed because we have some initial
information regarding the short vector between the base and rover
receivers. We know that the vector is exactly 0.200 meters long (the length
of the bar). We also know that the delta height of the vector is 0.000 (base
and rover receivers are at the same HI). Based on this given information,
the coordinates of the rover location can be established with a short 5
minute observation.

Processing of kinematic data initialized by using the bar does require one
special step not found in processing static data. The observation on the
bar by the rover receiver produces a unique point with it’s own unique Site
ID. The processing software must be told that this point is the rover
initialization point located on the bar. This is the only way that the software
knows to constrain the length of the vector and the delta height of the
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vector for processing. There are two ways to identify a point as the bar
initialization point:

- During data collection, the handheld software will automatically tag the
bar initialization point. Any point collected with the INI? flag set to Y in
Locus Handheld is tagged in the D-file as the bar initialization point. If
using Pocket Survey Control handheld software, any point collected
while an Initialization Type of Bar Point is selected will be tagged in the
D-file. The processing software will read this tag from the D-file and
automatically set the point as the bar point for processing.

- If a bar point was inadvertently not identified as such during data
collection, it can be set in the General tab of the Site Properties
dialog box.

Once the bar initialization point is identified, the processing of the
kinematic data is again similar to that of processing static data. If you
know the coordinates of the kinematic base station and want to hold them
fixed, enter them in the Control Sites tab. Otherwise, the software will use
an approximate position for the base station and hold it fixed for
processing automatically. The software will first determine the position of
the bar initialization point and then determine the position of the remaining
kinematic points.

• Known Point Initialization

If two or more points in your kinematic survey project area have known
coordinates, these points can be used to initialize your kinematic survey.
The base receiver is set up on one of the known points. The rover
observes the second known point for a short period of time (10 seconds
for example). This provides a rover point with known coordinates for the
processing software to initialize the kinematic survey. If initialization is lost
at any time during the kinematic survey, the same or a different known
point can be observed for re-initialization. The re-initialization point can
even be a point surveyed just moments ago during this kinematic survey.

It's very important to note that the relationship between the base point and
the known point to be used to initialize must be very accurately
established. For this reason, it is highly recommended that you only
initialize on a known point that has been previously established by a GPS
survey either with a direct measurement between the base and known
point or through a network including both the base and known point.

To process kinematic data where known point initialization was used, the
coordinates of the known point(s) must reside in the project file containing
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the kinematic data to be processed. This can be accomplished in different
ways:

- The kinematic data to be processed could be added to an existing
project file containing the known coordinates of the base point and
initialization points. For example, a project file may exist containing
data from a static survey performed earlier that established the
coordinates of the known points. The kinematic data to be processed
could be added to this project and processed. The processing
software will automatically grab the required coordinates for
processing of the kinematic data.

- The coordinates of the known points could be added to the project
containing the kinematic data to be processed by entering them in the
Control Sites tab.

If re-initialization was performed on a point observed earlier in the same
kinematic survey, there is nothing special that needs to be done to prepare
the software to accept this re-initialization. The software will automatically
access the coordinates of this point when needed.

• On-The-Fly Initialization

On-the-fly initialization requires no special data collection procedures. The
kinematic survey is initialized without a special initialization process. The
user simply turns on the rover GPS receiver and begins collecting
kinematic data. If the user can collect a long enough session of continuous
data without loose-of-lock on satellites, the kinematic survey will initialize
on it’s own.

The time period of continuous data required to ensure initialization varies
depending on a number of factors, the most important of which is GPS
receiver type. If using a dual-frequency receiver, such as the Ashtech Z-
Xtreme, on-the-fly initialization can occur with just a couple of minutes of
continuous data without loss-of-lock. Under some conditions, up to 10
minutes of data may be needed. On the other hand, if the GPS receiver
being used is a single-frequency receiver, such as the Locus, you could
require 20 minutes of continuous data for initialization.

Processing of kinematic data with on-the-fly initialization requires no
special steps compared to static processing. If you know the coordinates
of the kinematic base station and want to hold them fixed, enter them in the
Control Sites tab. Otherwise, the software will use an approximate position
for the base station and hold it fixed for processing automatically.
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Kinematic Surveys using Multiple Base Stations
It is possible to perform a kinematic survey with more than one base station.
Multiple base stations provide for redundant observations to the kinematic points
being surveyed. There are no special requirements to processing kinematic data
with multiple base stations. Follow the procedures outlined above as if there were
only one base station in the survey. The processing software will automatically
accommodate the other base stations. For example, let’s say that a kinematic
survey is performed using two base stations and a rover. At one base station, the
kinematic survey is initialized using the initializer bar. Data collection proceeds as
normal, as if there is only one base station.

During the processing of this data, the processing software will first process the
vector between the two base stations. Next, the software will process the vectors
between the base station with the initializer bar and all rover points. The software
knows which base station has the initializer bar by examining the approximate
positions of the base stations and the initialization point. Finally, the software will
process the vectors from the second base station to the rover points, using one of
the already processed rover points to initialize on.

Adjustment
In most situations, there is no benefit in adjusting vectors that have been collected
using the kinematic mode of data collection. This is because there is no
redundancy in most kinematic surveys. Only one observation exists between the
base and each rover point. This leaves nothing to adjust. The exception to this is
the situation were multiple base stations are used during the kinematic survey. In
this case, closed loops exist between the base points and each rover point. This
survey has redundancy therefore can be adjusted.

Conclusion

Once you have completed the pre-process analysis, processing, and post-
process analysis, and are satisfied the processed data have no observable errors,
you can adjust the data.
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6

AdjustmentAdjustmentAdjustmentAdjustment
Adjusting your survey observations is one of the most important tasks to ensure
accurate reliable results. A network adjustment is performed to accomplish two
results - to test for blunders and errors in the observations (vectors between
points in our case), and to compute final coordinates for your survey points which
are consistent with the existing control points that you used.

Only data sets with redundant observations (closed loops) benefit from an adjustment. Performing
an adjustment on radial vectors (such as those obtained from a kinematic survey with only one
base station) will not identify errors in the observations nor improve the accuracy of the points
surveyed.

Adjustment takes place after you have processed the raw data and are satisfied
that there are no unaccountable errors in the processed results. There are
typically two stages in the adjustment. The first, the minimally constrained
adjustment, is used to detect problems in the observations and control
coordinates. You may have to iterate several times, using a number of different
tools to check for blunders. Once you are confident that no blunders remain, you
can proceed to the second stage, the constrained adjustment, where you hold
fixed all the control points and readjust to obtain final site positions and
accuracies. The final site-pair relative accuracies are compared with the accuracy
specification in the Miscellaneous tab of the Project Settings dialog box.

This chapter takes a step-by-step approach through the adjustment procedure,
and highlights what tools you should use and when to use them. Since it is task-
oriented, it does not deal with the theory of adjustments in any depth. Instead,
refer to Appendix C, Post-Adjustment Analysis. You will find it helpful to review
this appendix before actually performing an adjustment.
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Minimally Constrained Adjustment

The first stage of adjusting your data set is to perform a minimally constrained
adjustment; the final product of this stage will be a blunder-free adjustment.

1. With an open project containing a processed data set, click on the
Adjustment Analysis tab of the Workbook window.

2. Notice all the fields are blank. No data are available until you perform an
adjustment on the data set.

You may choose to hold one site fixed at this point. However, if you do not, the software
automatically uses the site with the lowest uncertainty. It is important that you do not hold more
than one site fixed.

3. Press F7 to perform an adjustment or click the Adjustment button on the
toolbar.

A progress dialog box opens, indicating the adjustment progress and status;
you may cancel the adjustment at any time. Relevant messages are
displayed in the message window of the Workbook.

4. Once the adjustment is complete, data appear in the Adjustment Analysis
tab and the Network Rel. Accuracy tab of the Workbook window.

Table 6.1 describes the Adjustment Analysis tab.

Table 6.1. Adjustment Analysis Tab Description

Component Description

From—To Vector identifier. Format is xxxx – yyyy, where xxxx and yyyy are Site IDs.

Observed The month, day, and time for the vector.

Tau Test Displays FAIL if any residual component of the vector does not pass the
Tau test (refer to Appendix C, Post-Adjustment Analysis), otherwise
blank.

Delta X/Delta Easting The adjusted vector component in the x or easting direction.

Std Res. The residual of the adjusted vector component.

Delta Y/Delta Northing The vector component in the y or northing direction.

Std Res. The adjusted residual of the adjusted vector component.

Delta Z/Delta Elevation The adjusted vector component in the z or vertical direction.

Std Res. The residual of the adjusted vector component.
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The first test Ashtech Solutions performs is the Network Connectivity test.

This test ensures that the network does not contain any subnetworks that are
not connected. Refer to Appendix C, Post-Adjustment Analysis for more
information. After this test, text similar to the following appears in the
message window:

Network connectivity test: passed

Number of stations: 6

Number of vectors: 9

If this test fails, there are actually two or more unconnected networks in the
project. You must either observe more vectors to connect the networks,
exclude the vectors for all but one of the networks, or create a new project for
each network.

Ashtech Solutions then performs a chi-square test.

For more information about the chi-square test, refer to Appendix C, Post-
Adjustment Analysis. After performing this test, text similar to the following
appears in the message window:

Chi-square test: passed

Lower limit: 4.403788

Upper limit: 23.336664

Chi-square: 22.083307

Actual measurements may differ in the adjustment of your data files.

Refer to Appendix C, Post-Adjustment Analysis for details on what to do if
the chi-square test fails.

After passing the chi-square test, the program performs a tau test for each vector.

A tau test is performed on the residuals of each vector as a test for blunders.
The tau test result for each vector is displayed in the Adjustment Analysis
tab of the Workbook window. Only those vectors that fail the test are
indicated. For more details on the background of the tau test, refer to
Appendix C, Post-Adjustment Analysis.

Length The 3D spatial distance of the vector in the linear unit system selected in
the Project Setup.

Std Res. The residual of the adjusted vector length.

Table 6.1. Adjustment Analysis Tab Description (continued)

Component Description
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It is important to note that even if some vectors are flagged as failing the tau
test, if the residuals of the vectors are not significantly larger than those for
other vectors, it is probably acceptable to ignore the results of the test.

Other tests that are useful in detecting blunders, especially in larger
networks, are the Repeat Vector test and the Loop Closure test. Both tests
can be used to identify problem vectors - you can exclude them from further
adjustment if necessary. Appendix C, Post-Adjustment Analysis describes
these tests in detail.

5. If no residuals are flagged, you should now have a blunder-free adjustment.

Once the program determines that it has performed a blunder-free
adjustment, it checks to determine if each pair of points meets the relative
accuracy specification (known as a Site Pair QA Test). The lowest relative
accuracy is the attained accuracy of the survey, while uncertainties present
estimated accuracy of adjusted points.

6. If any vectors fail the QA test, you should investigate to determine why this is
before proceeding to the next stage of the adjustment. Please refer to
Appendix C, Post-Adjustment Analysis for details.

7. Once you are sure that all problem data has been removed from the
minimally constrained adjustment, examine the Network Rel. Accuracy tab
of the Workbook.

Table 6.2 describes the data presented in the Network Rel. Accuracy tab.

Table 6.2. Network Relative Accuracy Tab Confirm with Online Help

Component Description

Site Pair Vector identifier. Format is xxxx – yyyy, where xxxx and yyyy are Site Ids.

QA A quality indicator for the computed site pair relative error. Displays FAIL if the
relative error is greater than the allowable relative error determined from the
Desired Project Accuracy fields in the Miscellaneous Tab of the Project
Settings dialog box.

Horz. Rel. Error The horizontal relative error of the vector in the linear units system selected in
the Project Setup.

Vert. Rel. Error The vertical relative error of the vector in the linear units system selected in the
Project Setup.

Horz Rel. Accuracy The precision calculated using the relative error and the vector length. Use the
right-click menu to display the accuracies in parts per million (ppm) or as a ratio.

Vert. Rel Accuracy The precision calculated using the relative error and the vector length. Use the
right-click menu to display the accuracies in parts per million (ppm) or as a ratio.

Distance The distance between the two sites for which the site pair analysis was
conducted.
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The Network Rel. Accuracy tab provides information on the relative
accuracy of the survey by examining the relative accuracy of site pairs. The
lowest relative accuracy defines the relative accuracy of the survey. The best
time to determine the relative accuracy of a survey is after performing the
minimal constraint adjustment. Examining network relative accuracy at this
point will give you an indication of the internal accuracy of the survey. After
performing the constrained adjustment, the adjusted network will be distorted
to fit the control points held fixed. This may result in a lowering of the network
relative accuracy, which does not reflect the quality of the survey data but
reflects the quality of the control being held.

The site pair QA test found on this tab indicates if the associated site pair
meets the relative accuracy required to satisfy the desired project accuracy
set in the Miscellaneous tab of the Project Settings dialog box. If the
relative accuracy for a given site pair falls below the desired project accuracy,
the QA test fails and Fail displays in the field. If the QA test passes, the field is
blank.

For more details on relative accuracy and the site pair QA test, refer to
Appendix C, Post-Adjustment Analysis.

8. If more than one control point was entered in the Control Sites tab and only
one was held fixed (remember that you should hold no more than one fixed at
this stage), Ashtech Solutions performs a control tie analysis automatically. To
see the results, click on the Control Tie tab of the Workbook window.

This test provides an indication of how well your survey agrees with the
established control you have entered. If the ties to one of the control points
fail and are significantly larger from ties to other control points, then there is
good reason to suspect that that control point may be in error. This control
point should not be used in the constrained adjustment.

9. Once you have completed the minimally constrained adjustment and have
ensured that your network is free of blunders, you can hold fixed all of the
control points you have available and perform a constrained adjustment to
derive final site positions and network accuracy.

Constrained Adjustment

The purpose of this final stage is to adjust your network, holding all your control
sites fixed to obtain final positions that are consistent with the established control.

1. Go to the Control Sites tab of the Workbook window.

2. Change the fixed status for each control point.
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You can have points which are horizontal control only, points that are vertical
control only, and points which are both.

3. Click F7 to perform the adjustment again. You should see text in the
Message window similar to the following:
Adjustment type: Over constrained

Control stations Constraints

0002 Latitude Longitude Elevation

_ASH Latitude Longitude Elevation

4. At this stage you can inspect the Network Rel. Accuracy tab of the
Workbook window.

Examining the network relative accuracy of the constrained adjustment
provides details on the relative accuracy of the survey after holding fixed the
control points. In most cases, the relative accuracy of the survey decreases
from the minimally constrained adjustment to the constrained adjustment
since the survey has been distorted to fit the control.

5. Look at the Map View window and notice that the display has changed to
show the relative accuracies between the site pairs as error regions. This is a
good graphical tool to quickly determine if there are obvious problems in your
network.

6. If the site pairs pass the QA, the adjustment is constrained.

Uncertainties present estimated accuracy of adjusted points. The lowest
relative accuracy dictates the relative accuracy of the survey. Relative
accuracy will be less than that of minimally constrained adjustment due to
added constraints. Relative accuracy may fall below the accuracy
specification if problem control points are held fixed.

Figure 6.1 shows the tasks listed in this chapter.
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Figure 6.1. Adjustment Flowchart
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7

ReportsReportsReportsReports
This chapter covers the procedures for producing a printed copy of your project
data. The report software lets you select the information you want to print, and
automatically inserts the selected parameters into a standard RTF-formatted
report that can be edited and printed by any standard word processing program. It
is assumed that you have created a project and completed the processing
described in the preceding chapters, and you now want to compile the results.

Setting the Report Viewer Program

Although a report editor program, such as WordPad or MS Word was selected
during the installation of Ashtech Solutions, you can change the Report Editor
program at any time in the Program Setup dialog box.

Ashtech Solutions can use any of the following applications as a report editor:

• MS Word 6.0 through 2000.
• WordPad
• Write
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1. Select Program Setup from the Tools menu to open the Program Setup
dialog box (Figure 7.1).

The Preferred Report Editor field lists the full path for the word processor
application.

Any previously specified word processors can be selected by clicking the
arrow to the right of the Preferred Report Editor field and selecting from the
displayed list.

2. To specify and select a new word processor, click the Browse button,
navigate to and select the application in the Select Report Editor dialog box,
Figure 7.2, and click Select.

3. Click OK in the Program Setup dialog box to accept the changes and close
the dialog box.

Figure 7.1. Program Setup Dialog Box

Figure 7.2. Select Report Editor Dialog Box
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Generating a Report

The program has pre-specified reports than can easily be generated to view site
positions, project summaries, adjusted measurements, processed vectors, control
tie analysis, observation information, etc. If you want a specialized format for your
report, you can create one using the export functions described in Chapter 8,
Exporting Data.

1. Select Report from the Project menu to open the Project Report dialog box,
Figure 7.3.

Use the Project Report dialog box to select the content of your report. You
can click the + sign next to the Adjustment Results or Miscellaneous folders
to expand them with further topics.

2. Select the items in the Available Items listbox you wish to include in the
report, and click Add.

You must select and add one item at a time; you can not select several items
and add simultaneously as a group.

Use the Add All button to add every report topic in the Available Items listbox
to the report, or use the Remove All button to remove every report topic from
the report.

3. Click OK to close the Project Report dialog box and generate the report in
the specified word processing application. A separate report and page
generates for each selected topic.

Figure 7.3. Project Report Dialog Box
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4. Use the features of the word processing application to edit, save, and print as
needed. Figure 7.4 and Figure 7.5 show typical report formats.

Figure 7.4. Typical Site Positions Report

Figure 7.5. Typical Network Relative Accuracy Report

Network Relative Accuracy
report

Desired Horizontal Accuracy: 0.010m + 1ppm Date: 11/05/98
Desired Vertical Accuracy: 0.020m + 1ppm Project file: report.spr
Confidence Level: Std. Err.
Linear Units of Measure: Meters
______________________________________________________________________________________

Site Relative Allow. Horizontal Vertical Site
Pair Error(m) Error(m) Relative Acc Relative Acc Distance Pair QA

1 0205 Lat 0.001 0.010 1:259526 1:259526 259.527
DISC Lng 0.001 0.010

Elv 0.001 0.020

2 0205 Lat 0.002 0.010 1:28366 1:56733 56.733
EUC2 Lng 0.001 0.010

Elv 0.001 0.020

3 0205 Lat 0.006 0.010 1:485268 1:1455806 2911.613
MISS Lng 0.002 0.010

Elv 0.002 0.020

4 EUC2 Lat 0.002 0.010 1:118826 1:237652 237.652
DISC Lng 0.001 0.010

Elv 0.001 0.020

5 DISC Lat 0.006 0.010 1:464475 1:1393427 2786.855
MISS Lng 0.002 0.010

Elv 0.002 0.020
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Printing Views and the Workbook Window

The Map View window, Time Diagram window, or an individual Workbook tab or
common information stored in the Workbook tab can be printed in report format.

Printing Map View or Time View Windows
1. Verify that the window you wish to print is active.

2. Select Print from the Project menu to open the Print Setup dialog box.

3. Set the printer options as necessary and click OK.

Ashtech Solutions sends an image of the active window to the printer.

Printing the Workbook Window
1. Verify that the tab with information you want to print is active in the Workbook

window.

2. Select Print from the Project menu to open the Print Setup dialog box.

3. Set the printer options as necessary and click OK.

Ashtech Solutions sends the information from the current tab to the printer.

You can review the information before sending it to the printer by selecting
Print Preview in the Project menu.
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8

Exporting DataExporting DataExporting DataExporting Data
You to create customized ASCII export formats containing a wide range of
information from your project. You can save the formats you create for convenient
reuse, and use formats others have created on different machines. Additionally,
you can export project information in the following predefined formats:

• Ashtech O-file
• TDS coordinate file (*.cr5)
• NGS Bluebook files (B-file and G-file)

Exporting Data

The Export Data dialog box, Figure 8.1, is a standard File Save As dialog box.
Use it to export project information in a selected format to a specified directory.

Figure 8.1. Export Data Dialog Box
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Table 8.1 describes the components of this dialog box:

Exporting Processed Versus Unprocessed Data
Ashtech Solutions does not require processing prior to exporting. You can create
an export template which contains vector data with “From Site ID”, “To Site ID”,
and “Date and Time” fields, although no processed or adjusted vector information
is included.

Effects of Filtering
Filtered data will not export (refer to “Filtering Data” on page 41).

Table 8.1. Export Data Dialog Box

Components Function

Save In Determines which drive and directory to save the exported file.

File Name Enter the name of the export file. The program creates file names
with certain extensions required by format specification.

Save as type listbox A list of export formats available.

Save Button Click this button to retrieve the selected export file name, begin the
export process, and close the Export Data dialog box. If the
selected file already exists, Locus ProcessorAshtech Solutions
displays an overwrite message.

Cancel Button Click this button to cancel the export process, and close the Export
Data dialog box.

Help Button Click this button to access the Help system

Customize Button Click this button to open the User ASCII Template dialog box to
customize the export template. This button is only available if User
Defined ASCII is selected in the Save as type list.
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Export File Format Descriptions

Ashtech Solutions supports the following export formats. Select the format in the
Save As Type list:

• User-defined ASCII— The file extension is user-defined, but the default is
.uda.

• Ashtech O-file— This file is the standard Ashtech binary O-file. You can
create one file containing all vectors, or one file for each vector in the
project.

• TDS Coordinate file— This is the standard TDS .cr5 file format.
• Bluebook files— These files export vectors and site positions to NGS

Bluebook B-file and G-file formats.

User-Defined ASCII Files
The program lets you customize ASCII export files.This ASCII file allows you to
export data in a format that can be used by other software packages. These files
assemble project data into an ASCII file configured to your preferences. Create an
export template that specifies extension, delimiter, and type/arrangement of data
within the file.

The following procedure describes how to customize an ASCII export file.

Customizing an ASCII Export File
1. Once the project file is open, click the Export button or F8.

The Export Data dialog box opens, as shown in Figure 8.1.

2. Select User defined ASCII in the Save as Type drop down listbox.

3. Click Customize to open the User ASCII Template dialog box, Figure 8.2.

Table 8.2 describes the component in the User ASCII Template dialog box.
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4. Create a new or modify an existing ASCII template.

Table 8.2 describes the components of this dialog box.

Figure 8.2. User ASCII Template Dialog Box

Table 8.2. User ASCII Template Dialog Box

Component Description

Template Listbox Provides a list of all default and previously saved ASCII export
file templates

New Button Click this button to create a new template. The New Template
Name dialog box opens; enter a unique name and select
either Site or Vector Data output.

Delete Button Click this button to delete the selected template.

Modify Button Click this button to edit the selected template.

Promote Button Click this button to specify a file extension and file type
description and include the selected export template in the list
of defined export file types in the Save As Type list in the
Export Data dialog box. Click Demote to remove the selected
export template from the list of export file types in the Save As
Type list in the Export Data dialog box.

Data Selection
• Site Data
• Vector Data

• Export of Project site information
• Export of Project baseline information

Output Ext Lets you define extension of output file (default is .uda).

Template Viewing Lists fields in the selected template in Template list.

OK Button Click this button to use the selected template and close the
dialog box.
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Creating a User-Defined Format
1. If you click New or Modify in the User ASCII Template dialog box, the New

Template Name dialog box opens, Figure 8.3.

Use this dialog box to assign a name and select either Site or Vector as the
output data. You may not export both site and vector data in the same
template.

2. Once you enter a name and click OK, the User Defined Format dialog box
opens, Figure 8.4 and Figure 8.5, showing Site Data or Vector Data in the Field

Cancel Button Click this button to close the dialog box without using a user-
defined template.

Help Button Click this button to access the help system.

Figure 8.3. New Template Name Dialog Box

Table 8.2. User ASCII Template Dialog Box (continued)

Component Description
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Selection list, depending upon whether you select Site or Vector output data
in the New Template Name dialog box.

3. Use this dialog box to define the fields and structure of the ASCII export file.

Figure 8.4. User-Defined Format Dialog Box with Site Data

Figure 8.5. User-Defined Format Dialog Box with Vector Data
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Table 8.3 describes the components of the User Defined Format dialog box.

Table 8.3. User Defined Format Dialog Box

Component Description

Field Selection

Field Selection
List

Provides a list of available fields (refer to Table 8.4 for a description of
the available field names)

Field Width Specified maximum length of the field

Alignment Left, justified, or right alignment of text

Decml. Place Indicates precision (number of places after decimal). Active only for
numeric fields.

Quadrant Indicates either N/S and E/W, or +/-. Available only for Latitude and
Longitude fields.

Format Provides format for date and time field. Available formats are indicated
in list.

User Text Available only for Text field. Limited to 120 characters.

Export File Template

Enter Button Click this button to add the highlighted field to the template at current
cursor position.

Delete Button Click this button to delete the highlighted field from the template.

Clear All Button Click this button to delete all fields from the template.

Field Structure Provides a real-time structure of the ASCII template which will reflect
modifications through the use of the Enter, Delete, and Clear All
buttons.

Field Delimiters

Field Indicates choice of delimiters between each field (comma, semicolon, or
vertical bar).

Text Indicates choice of delimiters between text (single quotes, double
quotes, or none)

Buttons

OK Button Click this button to save any changes made to the export templates and
close the dialog box.

Cancel Button Click this button to close the dialog box disregarding any changes.

Save As Button Click this button to save the template to different template name.

Preview Button Click this button to view a preview of the field structure for the selected
template with simulated data (refer to Figure 8.6)
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Table 8.4 describes the available field types.

Help Button Click this button to access the help system.

Table 8.4. User-Defined Format Field List

Field Name Description

Information in File Header

[File Header Start] Start of the file header, fields between this and an end
field only display once at the beginning of output file.

[File Header End] The end of the header for the file

[Project Name] Name of the project

[Project File Name] Name of the project file

[Date/Time] Date. Can be in any one of the format selected in Format
Choice

[Linear Units] Name of the selected linear unit

[Confidence Level] The uncertainty level the user selected. “95% Error” or
“Std. Error”

[Desired Hor. Accuracy] Horizontal accuracy specified by the user

[Desired Vert. Accuracy] Vertical accuracy specified by the user

[Height System] Height system used. Either “Orthometric” or “Ellipsoidal”

[Coordinate System] The name of the coordinate system used

Information in Body of Report

Vectors Only

[From Site ID] The site ID of the fixed point

[To Site ID] The site ID of the unknown point

[Date and Time] The date and time of the start of the common data for the
vector.

[Measurement Type] The type of data used in the vector solution: L1 GPS, L1
GPS/GLN, L1/L2 GPS.

[Number of Satellites] The average number of satellites contained in the data
used to compute the vector.

Table 8.3. User Defined Format Dialog Box (continued)

Component Description
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[PDOP] The average PDOP (Position Dilution of Precision)
calculated from the observed data used to compute the
vector.

[Processed Vector Length] Length of the processed vector

[Proc. Vector length error] The uncertainty of the length at the selected confidence
level

[Proc. X component] X component of vector

[Proc. Y component] Y component of vector

[Proc. Z component] Z component of vector

[Proc. X comp. error] Error in X component of vector

[Proc. Y comp. error] Error in Y component of vector

[Proc. Z comp. error] Error in Z component of vector

[Proc. XY Corr.] The XY correlation of the processed vector

[Proc. XZ Corr.] The XZ correlation of the processed vector

[Proc. YZ Corr.] The YZ correlation of the processed vector

[Site Pair Distance] Distance between sites

[Site Pair Horz. Relative
Error]

The relative uncertainty between the two sites.

[Adj. X component] Adjusted X component of vector

[Adj. Y component] Adjusted Y component of vector

[Adj. Z component] Adjusted Z component of vector

[Adj. X comp. error] Error in adjusted X component of vector

[Adj. Y comp. error] Error in adjusted Y component of vector

[Adj. Z comp. error] Error in adjusted Z component of vector

[Adj. XY Corr.] The XY correlation of the adjusted vector.

[Adj. XZ Corr.] The XY correlation of the adjusted vector.

[Adj. YZ Corr.] The XY correlation of the adjusted vector.

Sites Only

[Site ID] The ID of the site

[The site descriptor] The site name

[Latitude] Latitude

Table 8.4. User-Defined Format Field List (continued)

Field Name Description
Exporting Data 95



synergy.book Page 96 Wednesday, February 14, 2001 8:19 PM
[Longitude] Longitude

[Latitude Error] Uncertainty in latitude

[Longitude Error] Uncertainty in longitude

[Grid Northing] Northing in grid system

[Grid Easting] Easting in grid system

[Grid EN Corr.] The EN correlation of the grid position.

[Grid EH Corr.] The EH correlation of the grid position.

[Grid NH Corr.] The NH correlation of the grid position.

[Local/Ground Northing] Northing in either the local grid system or the ground
system (whichever is currently active).

[Local/Ground Easting] Easting in either the local grid system or the ground
system (whichever is currently active).

[Local/Ground EN Corr.] The EN correlation of either the local grid system or the
ground system (whichever is currently active).

[Local/Ground EH Corr.] The EH correlation of either the local grid system or the
ground system (whichever is currently active).

[Local/Ground NH Corr.] The NH correlation of either the local grid system or the
ground system (whichever is currently active).

[Convergence] The grid convergence angle at the site.

[Scale Factor] The grid scale factor at the site.

[Elevation factor] The elevation factor at the site.

[Ellipsoidal Height] Ellipsoidal height

[Orthometric Height] Orthometric height

[Ellipsoid Height Error] Uncertainty in Ellipsoid height

[Hor. Fix Status] Horizontal fix status (“Fixed” or empty)

[Vert. Fix Status] Vertical fix status (“Fixed” or empty)

[Control Type] “Hor” for horizontal only, “Ver” for vertical only and “Hor/
Ver” for both.

[Position Status] “Raw”, “Processed”, or “Adjusted” depending on status of
position.

Table 8.4. User-Defined Format Field List (continued)

Field Name Description
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4. Select the component or field you wish to add to the template, and click Enter.

If you want the template to have a header, you must place the header fields at
the beginning of the template.

5. Continue adding parameters to build the template to your specifications.

6. Click the Preview button to view a preview of the field structure for the selected
template with simulated data.

Figure 8.6 shows the User-Defined Format dialog box with a template built,
and Figure 8.7 shows the Preview dialog box for the template containing
simulated data.

7. Click Save As in the User-Defined Format dialog box to save the template.

8. Click OK in the User ASCII Template dialog box to use selected template and
close dialog box.

Figure 8.6. User-Defined Format Dialog Box with Template

Figure 8.7. Preview Dialog Box with Simulated Data
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9. Click Save in Export Data dialog box to export data in user-defined ASCII
export file.

Promoting a Data Type
If you would like a User ASCII Template to be available as a selection in the Save
as type list of the Export Data dialog box, click Promote in the User ASCII
Template dialog box when the template is selected. There is no requirement to
promote a template. All templates are saved and accessible for future use in the
Template List of the User ASCII Template dialog box.

Using Exported Data

Using User-Defined ASCII Files
Create a user-defined ASCII files to customize the table of information you want
to import into a third-party software package.

A user-defined ASCII file can be loaded into Microsoft Excel so further modifications and data
analysis can be done.

Using O-Files
The O-file is a binary format of the vector-only data in the project. After you select
O-file in the Export Data dialog box, Ashtech Solutions exports the processed
and/or adjusted vector information to the proprietary standard file. After you select
Ashtech O-file in the Export Data dialog box, Ashtech Solutions exports the
processed vector information to the O-file format. This file can be imported into
other projects or other software packages.

Using TDS Coordinate Files
The TDS Coordinate file format *.cr5 is the standard TDS coordinate output file
which you can use to import position information into other software packages.

Using Bluebook Files
Ashtech Solutions creates NGS Bluebook B-file and G-file formats for vectors and
site positions to import into other software packages.

Since Ashtech Solutions contains only a subset of the information required in the
NGS B-file and G-file, you may need to supplement the generated files with
additional information. Use the NGS CR8BB and CR8G programs for this task.
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9

Coordinate TransformationsCoordinate TransformationsCoordinate TransformationsCoordinate Transformations
One of the primary advantages of Ashtech Solutions is the ability to work within
your own coordinate system from the start of your project - you no longer need to
be concerned with transforming to and from the WGS-84 datum, to which all GPS
data references. Ashtech Solutions allows you to work in four types of horizontal
coordinate systems: Local Grid, Grid System, Ground, or Geodetic. In addition you
can choose to use either ellipsoidal heights or orthometric heights. Although
Ashtech Solutions includes many predefined grid systems and geodetic datums,
you can easily create your own custom coordinate system.

The four types of coordinate systems can be seen to build upon one another. At
the heart of any system lies the geodetic datum, with a known relationship to WGS-
84, represented by the Geodetic system. On top of that might exist a Grid system,
consisting of one or more zones, each utilizing one of the several available
projections. Finally, a Local Grid can be superimposed over a Grid system. A
Ground system builds upon a Geodetic system only. It has no relationship to a
selected Grid or Local Grid system.

Typically you select or define the coordinate system you wish to use when you
create a new project. From that point on, all coordinates are presented in that
system. However, it is possible at any time to change to a different system, and all
your coordinates automatically transform to the new system.

Experience indicates that users work primarily in the same coordinate system - for
convenience, the coordinate system in a new project is automatically set to the
system that was used last.
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Selecting a Predefined Coordinate System

To select a predefined coordinate system:

1. From the Coordinate System Tab of the Project Settings dialog box, select
a System Type (Local Grid, Grid, Ground, or Geodetic).

2. After you select System Type, the available choices appear on the display.

3. Select the appropriate choice (s) and click OK.

Defining a New Geodetic Datum

If a Geodetic Datum you want to use does not already exist in the pre-defined datum
database, you can define and store a new Geodetic Datum for use in this and future
projects.

In Ashtech Solutions, defining a new datum means defining the relationship
between the new datum and the WGS84 datum. Since GPS observations are
referenced to WGS84, defining the relationship between WGS84 and other datums
allows for point coordinates determined by GPS to be transformed to these other
datums.

To properly define the relationship between WGS84 and a new Geodetic Datum,
the following transformation seven parameters must be known:

• The X,Y, and Z translation between the origins of the two datums
• The rotation about the X, Y, and Z axis to align the axes of the two datums.
• Scale difference between the two datums.

These parameters must be supplied to Ashtech Solutions in a manner that defines
the transformation from the new Geodetic Datum to WGS84.

If the transformation parameters relating your new datum to WGS84 are unknown,
you can use Ashtech Solutions to estimate them. To estimate the set of
transformation parameters, you must have the following information:

• Two points with known horizontal coordinates in both the WGS84 and new
datums.

• Three points with known vertical coordinates in both the WGS84 and new
datums.

This is the minimum set of known coordinate values required to compute the seven-
parameter relationship between WGS84 and the new datum. Additional values
allow for calculating statistics defining the quality of the estimated parameters and
identifying problems with the known coordinates.

1. From the Coordinate System Tab of the Project Settings dialog box, select
Geodetic as the system type.
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2. Select NEW as the Geodetic datum, and click the Define button

3. In the Datum Definition dialog box, Figure 9.1, enter the name for the new
datum.

4. Select the ellipsoid which the new datum uses (refer to “Defining an Ellipsoid”
on page 101).

5. Enter the shifts and rotations in the x, y, and z directions, and the scale
difference.

To estimate the transformation parameters using a set of points, refer to
“Estimating Datum Transformation Parameters” on page 102.

6. Click OK to save the datum parameters and close the Datum Definition
dialog box.

Defining an Ellipsoid
An ellipsoid is a primary component in the definition of a datum. If you wish to define
a datum that is based on an ellipsoid not found in the predefined ellipsoid database,
you can define a new ellipsoid.

The definition of a new ellipsoid requires values of the following ellipsoid
parameters:

• Semi-major axis
• Inverse flattening

If the semi-minor axis is known rather than the inverse flattening, the inverse
flattening can be calculated using the following equation:

Figure 9.1. Datum Definition Dialog Box

1 f⁄ a a b–( )⁄( )=
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where:

1/f = Inverse flattening

a = Semi-major axis

b = Semi-minor axis

1. In the Datum Definition dialog box, select NEW in the Ellipsoid dialog box,
and click the Define button .

2. In the Ellipsoid Definition dialog box, Figure 9.2, enter the name for the new
ellipsoid, the semi-major axis, and the inverse flattening.

3. Click OK to save the new ellipsoid and close the Ellipsoid Definition dialog
box.

Estimating Datum Transformation Parameters
If you do not know the transformation parameters for a custom geodetic datum, but
know the coordinates in both the local and WGS84 datums for a common set of
points, you can estimate the transformation parameters. Ashtech Solutions uses
industry standard equations to calculate transformation parameters (7-parameter
similarity transformation).

To estimate the set of transformation parameters between WGS84 and a new
datum, you must have the following information:

• Two points with known horizontal coordinates in both the WGS84 and new
datums.

• Three points with known vertical coordinates in both the WGS84 and new
datums.

This is the minimum set of known coordinate values required to compute the 7-
parameter relationship between WGS84 and the new datum. Additional values
allow for calculating statistics defining the quality of the estimated parameters and
identifying problems with the known coordinates.

If you have loaded data into the project, the sites are available to use for the
transformation calculation. After selecting a site, the coordinates appear as base
coordinates. The base coordinates can be edited, and any changes made are saved

Figure 9.2. Ellipsoid Definition Dialog Box
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to the data set.

1. From the Datum Definition dialog box, click the Estimate..... button to open
up the Datum Transformation dialog box, Figure 9.3.

2. Any sites set as control sites in the project are listed in the Data
Transformation Parameter Estimation dialog box. If you do not wish to use
any of these control sites in the transformation calculation, uncheck the ON
box.

3. Select a site loaded into the project by clicking the arrow at the right of Site ID
and selecting a site

-OR-

Enter the point’s Site ID in the Site ID display.

If you selected a site, both the WGS-84 and local datum coordinates are
listed.

4. Enter or edit the latitude, longitude, and elevation for both the local and WGS-
84 systems, if necessary.

5. Verify the On box is checked for the point.

6. Repeat for all points

7. After entering all points, click Calculate to calculate the transformation
parameters. The Estimated Parameters box at the bottom of the dialog box
box lists the computed transformation parameters (Figure 9.4).

Figure 9.3. Data Transformation Parameter Estimation Dialog Box
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If you entered more than the minimum number data points to calculate the
transformation parameters, Ashtech Solutions also computes residuals for
each point.

8. Click OK to save the transformation parameters to the datum, and close the
dialog box.

9. The actual point information is not saved and is not displayed the next time
the Data Transformation Parameter Estimation dialog box is opened.

Figure 9.4. Transformation Parameter Dialog Box with Estimated
Parameters
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Defining a New Grid System

If a Grid System you want to use does not already exists in the pre-defined Grid
System database, you can define and store a new Grid System for use in this and
future projects.

The following parameters are required to define a new Grid System:

• Reference Geodetic Datum- the new Grid System must be based on a
defined geodetic datum. You can select an existing pre-defined datum
from the database or define a new datum.

• Projection type- you must select a projection type for your Grid System
from the following projection types:

- Lambert Conformal Conic
- Lambert Conformal Conic 27 (for State Plane Coordinate System

1927)
- Transverse Mercator
- Transverse Mercator 27 (for State Plane Coordinate System 1927)
- Oblique Mercator
- Stereographic
- Stereographic Double

• Projection parameters for each desired zone of the Grid System- you must
enter the defining parameters of your Grid System. A different set of
parameters are required based on the projection type selected. If more
than one zone will exist in your new Grid System, defining parameters are
required for each zone.

1. From the Coordinate System Tab of the Project Settings dialog box, select
Grid as the System Type.

2. Select NEW in the Grid System combo box, and click the Define button .

3. In the Grid System Definition dialog box, enter the name for the Grid
System.

4. Click the Define button to open the Zone Definition dialog box and create the
zone for the grid system.

Figure 9.5. Grid System Definition Dialog Box
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5. Enter the name of the zone in the Name field.

6. Select the Geodetic Datum on which the zone is based.

7. Select the map projection type you wish to use for the project and zone.

8. Enter the projection parameters for the zone.

9. Click OK to save the zone and close the Zone Definition dialog box.

10. Click OK in the Grid Definition dialog box to close it and return to the
Coordinate System dialog box.

Defining a New Local Grid System

If a desired Local Grid System does not already exist in the Local Grid System
database, you can define and store a new system for use in this project and future
projects.

A Local Grid System is based on a regional Grid System, such as State Plane
Coordinate System 1983 (SPCS83), or a global Grid System, such as Universal
Transverse Mercator (UTM). Starting with the regional or global Grid System,
transformation parameters are defined to transform these Grid System coordinates
to the Local Grid System. In Ashtech Solutions, the regional Grid System or global
Grid System on which the Local Grid System is based is called the Base Grid
System.

Defining a Local Grid System can be accomplished in one of two ways:

• You can enter the known transformation parameters between the Local
Grid System and the Base Grid System. The required transformation
parameters are Easting and Northing translations between the origins of

Figure 9.6. Zone Definition Dialog Box
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the coordinate systems, Rotation about the vertical axis, and Scale
difference between the systems.

• Supply the software with a least two points with known horizontal
coordinates in both the Local Grid System and the Base Grid System.
From these two points, the transformation parameters relating the two
systems will be calculated.

These parameters must be supplied in a manner that defines the transformation
from the Base Grid System to the Local Grid System.

To define a new local grid system:

1. From the Coordinate System Tab of the Project Settings dialog box, select
Local Grid in the System Type display.

2. Select NEW in the Local Grid System display, and click the Define button .

3. In the Local Grid System Definition dialog box, type the name for the local
system.

4. Select a Base Grid System and Base Zone. You can define your own base
grid system by clicking the Define button.

5. If you know the transformation parameters, enter the Easting Shift, Northing
Shift, Z Rotation (rotation about a vertical axis), Scale Difference, and centroid
coordinates (optional) to convert the selected base grid to the local grid
system. Otherwise you need to calculate the parameters - refer to “Estimating
Local Grid Transformation Parameters” on page 108.

Positive rotation from the base grid to the local grid is in a counterclockwise
direction.

6. Click on OK to save the local grid.

Figure 9.7. New Local Grid Definition Dialog Box
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Estimating Local Grid Transformation Parameters
If you do not know the transformation parameters for a local grid system, but know
the coordinates in both the local and base grid systems for a common set of points,
you can estimate the transformation parameters. The base grid system is arbitrary.
It can be any pre-defined regional (State Plane Coordinates 1983 for example) or
global (UTM for example) grid system that is pertinent to your area.

To estimate the set of transformation parameters between WGS84 and a new
datum, you must have two points with known horizontal coordinates in both the
local grid system and the base grid system.

This is the minimum set of known coordinate values required to compute the
transformation parameters relating the two systems. Additional values allow for
calculating statistics defining the quality of the estimated parameters and identifying
problems with the known coordinates.

If you have loaded data into the project, the sites are available to sue for the
transformation calculation. After selecting a site, the existing coordinates appear
as base coordinates. The base coordinates can be edited, and any changes made
are saved to the data set.

1. From the Local Grid System Definition dialog box, click the Estimate...
button to open the Local Grid Transformation Parameter Estimation dialog
box, Figure 9.8.

Figure 9.8. Local Grid Transformation Parameters Estimation Dialog Box
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2. Any sites set as control sites in the project are listed in the Local Grid
Transformation Parameter Estimation dialog box. If you do not wish to use
any of these control sites in the transformation calculation, uncheck the ON
box.

3. Select a site loaded into the project by clicking the arrow at the right of the
Site ID display and selecting a site

-OR-

Enter the point’s Site ID in the Site ID display.

If you selected a site, both the WGS-84 and local datum coordinates are
listed.

4. Enter or edit the northing and easting grid coordinates for both the local and
base grid systems, if necessary.

5. Verify the On box is checked for the point.

6. Repeat for all points

7. After entering all points, click Calculate to calculate the transformation
parameters. The Estimated Parameters box at the bottom of the dialog box
lists the computed transformation parameters (Figure 9.9).

If you entered more than two data points to calculate the transformation
parameters, the program computes residuals for each point. You can use the
residuals to determine if any point is inconsistent with the others. If a point has
residuals much greater than the other points, the data point may be suspect
(or incorrectly entered).

The far right column in the dialog box gives you a quick indication of the
relative sizes of the residuals. Verify the coordinates and recalculate, or
recalculate the transformation parameters excluding the point(s). To exclude a
point, uncheck the On check box and click Calculate to recompute the
transformation parameters. Now the residuals for all checked points are 0
indicating that they are consistent.
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8. Click OK to save the transformation parameters to the local grid, and close
the Local Grid Transformation Parameters Estimation dialog box.

9. To produce a final report of your parameter estimation, click the Report
button.

A predefined report format opens in the pre-defined report editor, and lists the
points used in the estimation, new parameters, and the residuals.

Defining a New Ground System

Create a custom Ground System when you wish to produce coordinates in your
project area that are compatible with point coordinates derived using conventional
total stations.

1. From the Coordinate System dialog box, or the Coordinate System Tab of
the Project Properties dialog box, select Ground as the system type.

[,

Figure 9.9. Local Grid Transformation with Estimated Parameters
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2. Select NEW as the Ground System, and click the Define button . to open
the Ground System Definition dialog box (Figure 9.10).

3. Enter the name of the ground system in the System Name field.

4. Select the Geodetic Datum on which the ground system is based.

Selecting a geodetic datum is required only if you wish to determine
orthometric heights for the ground system by using a geoid model. A geoid
model is specific to a datum. If you use a particular geoid model with your
ground system, then select the geodetic datum which corresponds to the
geoid model.

5. Click the arrow to the right of the Point ID field and select the origin point for
the ground system from the list presented.

After selecting an origin point, the latitude and longitude stored in the project
for the selected point will be displayed.

If you would rather set the origin point to a location other than an existing
project point, simply enter the latitude and longitude of your origin without
selecting a project point. By default, the ground coordinates of the origin point
are defined as (0,0). You can enter values other that (0,0) as ground
coordinates for the origin point. This is helpful when the origin point is in the
center of the project site. Assigning ground coordinates such as
(10000,10000) to the origin point will lessen the likelihood of some of the
project points having negative ground coordinates.

6. Enter the desired coordinates of the origin point, in the ground system, in the
Ground Northing and Ground Easting fields.

Figure 9.10. Ground System Dialog Box
Coordinate Transformations 111



synergy.book Page 112 Wednesday, February 14, 2001 8:19 PM
7. Click the radio button corresponding to the method for defining the 0 º
azimuth for the ground system: To Grid North, To Point, or Angle.

• The To Grid North option defines 0° azimuth of the Ground System to
match Grid North.

• The To Point option defines 0° azimuth of the Ground System as the
azimuth between the origin point and a second point defined by either
selecting the point from the list of existing points in the project or defining a
new point by entering the Latitude and Longitude of the point.

• The To Angle option defines 0° azimuth of the Ground System as offset
from Grid North by the entered angle. A positive angle results in the 0°
azimuth of the Ground System being rotated counter-clockwise from Grid
North.

8. Click OK to save the ground system and close the dialog box.

Height Systems

The program has the ability to work with either orthometric heights (heights above
the geoid, or approximate mean sea level) or ellipsoidal heights (heights above the
same datum used for your horizontal coordinates). It is important to know what
height system your control coordinates are in so you can select it when creating
the project.

In the Coordinate System tab of the Project Settings dialog box, check the box
corresponding to the height system.

If you choose orthometric, you must select a geoid model as well. Use the geoid
model to define the relationship between the orthometric heights used and the
ellipsoidal heights that Ashtech Solutions uses to process and adjust survey data.

The program provides several geoid models, including Geoid99 (for the US),
GSD95 (for Canada) and EGM96 (worldwide coverage). Depending on the datum
you select, you may have the option to choose between several regional models,
or you may be restricted to the global model, because each regional model is
referenced to a specific datum. If you have more than one option, we recommend
that you select a regional model since is more accurate for your area.

The height displayed depends on the height system selected in the Coordinate
System tab.

The use of local height systems, which vary considerably from mean seal level (MSL) for
orthometric heights, may adversely affect your results.
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A Note Concerning NADCON

If you select a datum which uses the NADCON transformation, you must use
orthometric heights, because NADCON is a 2-D transformation, and ellipsoid
heights are meaningless.

It is very important that all vertical control heights are based on the same vertical datum, e.g., NAVD-
29. Mixing heights from different vertical datums causes unpredictable and erroneous results.
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Mission PlanningMission PlanningMission PlanningMission Planning
This appendix describes the planning operations to perform in the office prior to
collecting data in the field. Efficient field operations require prior knowledge of
satellite availability and configuration, that is, accurate data is obtained more
quickly when more satellites are widely dispersed across the sky at higher
elevations.

For example, there may be times when fewer than four satellites are available; or,
all the available satellites may be clustered in one small area of the sky (i.e., poor
geometry), or, some sites may be near buildings or structures that obstruct
satellite visibility.

Mission Planning lets you determine optimum times for data collection, and set up
various parameters and constraints:

• Determine DOP (dilution of precision) for a selected site during a
specified time interval

• Define obstructions, if any, at selected sites
• Determine the number of satellites available at a selected site at a

selected time

Ideally, you should plan your project so you have at least four satellites widely
dispersed across the sky throughout the data collection period. If you are doing a
kinematic survey, five satellites must be visible at all times during the survey.

Almanac Files

A current almanac is important for accurate planning. Mission Planning warns
you when an almanac file is older than 60 days from the planning date. Although
you can use Mission Planning with an almanac file older than 60 days, be aware
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the almanac information will not be current, thus satellite orbits and health may be
incorrect.

The GPS receiver continuously updates its internal almanac file as it collects data.
You can obtain a current almanac file by collecting data for at least 15 minutes,
then downloading the almanac file from the receiver. By default, Mission Planning
uses the latest almanac file available in the bin folder, unless you change the
folder or almanac file using the Satellite Configuration dialog box.

Be aware that the almanac changes constantly, and a given almanac becomes
invalid over time. You can tell the date of the almanac from the file name. For
example, a typical almanac file might be named alm 98.182, where alm indicates
the file is an almanac, 98 indicates the year, and 182 is the day of the year.

In actual practice, you would always use a current almanac, which you can obtain
in either of two ways:

• Call Customer Support; Customer Support will send you a current
almanac via e-mail.

• Set up your GPS receiver and collect data for about 15 minutes. The
receiver automatically generates a current almanac using data
received from the satellites. You can then download this almanac to
your PC as described elsewhere in this manual.

When to Use Mission Planning

The usage of Mission Planning depends on the type of survey and obstructions
that may exist at any of the sites in the project.

There are some locations and periods when satellite availability and geometry are
poor, however, the locations are generally localized, and the time periods last a
couple of hours at most. When data collection periods are long, 45 minutes or
more, these short periods of poor availability and poor geometry normally have
little effect on accuracy. But when data collection periods are short, 15 minutes or
less, poor availability and geometry can greatly affect accuracy, especially in
kinematic data collection. In kinematic mode, it is common to collect 10 seconds
or less of data on a point. If a DOP spike (short period of time with a very high
DOP value) occurs during that time period, the accuracy for this point degrades.
The accuracy of other points in the same kinematic session could be very good.
Therefore, Mission Planning plays a critical role when performing surveys with
short observation times.

Obstructions at a site adversely affect satellite availability and geometry for that
site. Obstructions can be so severe that the site may not be suitable for GPS
observation. The only way to determine the impact of obstructions is to examine
the effect of the obstructions on satellite availability and geometry at any
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obstructed site. Mission Planning lets you define obstruction information for each
site in a survey. With the obstructions defined, satellite availability and geometry
are analyzed to determine which sites are suitable for GPS observation and the
best time to collect data at each obstructed site.

If there are no obstructions, enter one site into Mission Planning near the center of
the survey area to examine satellite availability and geometry for the entire survey.

Starting Mission Planning

1. From the Windows 95 or Windows NT desktop, from the Start menu
Programs folder, select Planning from the Ashtech Solutions menu.

The Mission Planning main window opens, as shown in Figure A.1.

You can start Mission Planning from Ashtech Solutions by selecting Mission Planning from the
Tools menu.

2. Near the top of the window is a 24-hour time scale (Figure A.2), to specify the
time interval you want to determine DOP and satellite availability. Set the time
interval using the two sliders above the scale. To set the start time of
the interval, click on the left slider, hold the mouse button down, and move the

Figure A.1. Mission Planning Main Window
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slider to the desired start time. Similarly, set the end time of the interval using
the other slider. The specified interval appears in red.

Selecting Satellites and the Almanac

The setup menu allows you to change several parameters such as the satellite
configuration, the almanac used, the satellite cut-off angle, and the display mode.

Satellite Configuration
Select Satellite Configuration from the Setup menu to open the Satellite
Configuration dialog box, Figure A.3,.

Figure A.2. Time Scale

Figure A.3. Satellite Configuration Dialog Box

Left slider sets
beginning time

Right slider sets end
time
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Use the Satellite Configuration Dialog Box to define:

• which satellite system to use
• which individual satellites use
• the directory where almanac files are stored (default is the executable

directory).
• which almanac file to use in this project.

There are two lists of satellites, one each for GPS and GLONASS. In these lists,
each satellite has a check box next to it. Additionally, there are two buttons at the
bottom of each list to switch on/off all the satellites in a particular system. These
buttons are useful if you wish to quickly select or clear all the satellites in the
panel.

Use the System check boxes at the bottom of the screen to select which system
to use. To select the satellite system(s) you want to use:

1. Check the GPS box to use only GPS.

2. Check the GLONASS box to use only GLONASS.

3. If you have a receiver and software capable of using both systems, check
both GPS and GLONASS.

To select individual satellites, click on the check box next the satellite. A check
mark indicates it is selected.

If a check does not appear it means that the system to which the satellite
belongs has been deselected. Check the appropriate box in the Systems
box.

If there is a red line underneath the satellite number, then that satellite is
unhealthy according to the almanac. You may select unhealthy satellites, but
be advised that your session may contain bad data.

If the box is grayed out, there is no entry in the almanac for that satellite and it
is not available.

The satellite selections you make in this dialog box apply to all open windows
in Mission Planning. For example if you have the Sky Plot open and deselect
all GLONASS satellites, when you click OK, the Sky Plot updates
automatically.

Changing the Almanac

An almanac file is a file downloaded from the receiver containing satellite location
information, and it is important that the almanac file be as current as possible. By
default, Mission Planning uses the most recent almanac file in the bin folder.
Therefore copy the almanac file you downloaded from your receiver to this folder.

You can change the almanac file selected folder should you wish to store the
almanac files with your project data.
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1. If you need to change the path to the new almanac, click the Change Dir
button to open the Open File dialog box in the Satellite Configuration dialog
box.

2. Navigate to the directory where the almanac file is stored, and click OK to
select the new path. If there are no almanac files in the directory you will not
be able to click OK - in this case click Cancel.

3. Select the almanac you wish to use by click on the arrow to the right of the
Almanac display and selecting an almanac from the list.

The Sky Plot, Satellite Visibility Plot, and DOP Plot update to reflect the
contents of the new file.

4. To accept changes, click OK. To cancel changes, click Cancel.

Creating a New Project

Mission Planning Projects are used to store sites, but are independent of Ashtech
Solutions projects. In the bin folder of the Ashtech Solution directory is a sample
Mission Planning project with many United States cities listed.

1. Select New from the Site List menu.

2. The Site Editor dialog box opens, Figure A.4, where you can enter new sites
to view satellite availability. To create a New Site, see “Adding a Site to the
Project” on page 122.

Figure A.4. Site Editor Dialog Box
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Opening a Existing Project

1. Select Open from the Site List menu. The Open dialog box opens.

The Open dialog box lists the available projects.

2. Navigate to the directory where the project file is located and select the
project, or navigate to the bin folder and select usacities.spl.

3. Click Open to open the project and the Site Editor dialog box, Figure A.5.

The Site Editor dialog box displays the position and altitude data for a site. The
Local-GMT field in the lower left corner is important and displays the hours
difference between the local time and Greenwich Mean Time.

Make sure the Local-GMT number is correct for the site’s time zone as listed in
Table A.1.

Figure A.5. Site Editor Dialog Box

Table A.1. Time Zone Table

Local Time
Zone

Standard
Time

Daylight
Time

Eastern -5 -4

Pacific -8 -7

Central -6 -5

Mountain -7 -6
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Saving a Project

To save the project with all sites and obstructions, select Save from the Site List
menu.

Adding a Site to the Project

The Dilution of Precision (DOP), satellite geometry, and availability depend on a
site’s location. Typically these values remain fairly consistent over 1-2 degrees of
latitude or longitude. Therefore if no sites in the projects have obstructions, then
one site can be used for the entire project. Sites can be created by two methods in
the site editor: entering a latitude and longitude, or by selecting a location on a
world map.

1. In the Site Editor dialog box, Figure A.6, enter a name for the site in the Site
Name field.

2. If necessary, enter a brief description of the site to assist you in referencing
the site in the Site Description box.

3. Enter the site’s latitude and longitude in the corresponding fields.

-OR-

Click the Map button to open the Site Location on Map dialog box, Figure
A.7, and click on the approximate site location. Then click OK to accept the
site and close the dialog box.

Figure A.6. Site Editor Dialog Box
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4. Enter the approximate altitude of the site above sea level.

5. Make sure the Local-GMT number is correct for the site’s time zone (Table
A.1).

6. Click Add to save the site to the project.

7. Click Select to close the Site Editor dialog box, and use the site when
viewing the DOP and Sky Plots.

8. The Status bar lists the selected site name and coordinates.

Options

Use the Options dialog box to define

• Mode
• The display time interval
• The cut-off angle
• Whether obstructions are on or off
• To use the last-used almanac automatically at start-up

To open the Options dialog box, Figure A.8, select Options from the Setup
menu.

Figure A.7. Site Location on Map Dialog Box
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Positioning Mode
You can choose between 2-D and 3-D positioning modes. If you are solely
interested in horizontal positioning and are not concerned with height, you may
choose 2-D. This option had more importance in the past when there were fewer
satellites available and there were no receivers capable of simultaneous GPS and
GLONASS data collection. Constraining the positioning mode to 2-D meant that
you could work with only three satellites, a sometimes common occurrence.
However, this should be much less of a consideration now that there are always
more than four satellites in view. The recommended selection is 3-D.

Display Time
You may also select the time interval at which the DOP and availability values are
calculated. You have a choice between 5 and 15 minutes. The basic difference is
that 15-minute intervals allow quicker calculation of the DOPs, while a 5-minute
interval is slower but gives a better picture of how the satellite constellation
changes over time when you are zoomed in on a small time span.

CutOff Angle
The cutoff angle is the angle above the horizon below which you wish to ignore
satellites. It is a good idea to have a value of at least 10 degrees here, since
satellites at low angles are subject to atmospheric refraction and multipath
reflection. By default the cutoff is set to 15°.
To change the Cutoff Angle:

1. Select Options from the Setup Menu to open the Options dialog box opens
(Figure A.8).

2. Enter a new cutoff angle and click OK. The Options dialog box closes and
the Sky Plot and DOP Plot windows updates after you click in them.

Figure A.8. Options Dialog Box
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Obstructions On/Off
There is a check box to apply or remove any obstructions you have defined for the
current site. The obstructions are not destroyed if you deselect this box - they are
merely ignored and can easily be restored by rechecking the box.

Load Last Almanac
The final option in this dialog box allows you to use the last-used almanac the next
time you start Mission Planning. This overrides the default behavior of Mission
Planning which is to load the most recent almanac in the current directory.

Clicking OK updates all open windows with changes.

Clicking Cancel ignores changes.

Satellite Plots

Having selected a site and setting the desired options, you are now ready to view
the satellite plots to plan your mission.

Mission planning provides three different plots and graphs that you can examine.
Each plot provides a different perspective on satellite visibility, location, and
availability. All plots are accessed from the VIEW menu. The three plots that are
available are:

• The Satellite Visibility Plot indicates when individual satellites are visible
• The DOP Plot indicates the total number of satellites available and the

DOP values versus time
• The Sky Plot is a polar plot of the satellites as they move across the sky.

You decide which plot is most useful. However, in general, the DOP Plot is the
most helpful, as the availability and strength of the geometry are usually the most
important factors in planning a mission.
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Using the Satellite Visibility Plot
The Satellite Visibility Plot, Figure A.9, shows when satellites are available.

The time scale on the horizontal axis corresponds to the selected time span in the
Time Control bar. The vertical axis lists the satellite PRN numbers for the
satellites you have selected in the Satellite Configuration dialog box.

If you have selected both GPS and GLONASS, there may be too many satellites
too fit in the window vertically. In this case a vertical scroll bar becomes active on
the right side of the screen. Use this to move up and down the list.

A color bar to the right of the satellite ID number indicates when it is visible at the
selected site.

Select a time period for your survey when the most satellites are available for an
extended period. For any particular time you can find the number of satellites
available by counting the number of bars crossing that time period.

This window is most useful for detecting when individual satellites are visible. For
example, if you are interested in GPS satellite 28 you can easily see it on this
graph. A more useful view for seeing the total number of satellites available is the
combined Sky Plot.

Figure A.9. Satellite Visibility Chart
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Using the DOP Plot
The DOP Plot displays the DOP components and satellite availability for the site
on the specified day and time.

1. With a site selected, select DOP Plot in the View Menu.

2. The DOP Plot window opens for the selected site, the selected date, and the
selected time (Figure A.10).

The DOP scale on the left edge of the display shows the DOP values; a DOP
value of 4 is generally considered the maximum allowable for reliable data
collection.

The illustration shows two peaks in the DOP value, one peak just before 17:00
hours, and another just before 21:00 hours; thus it would be best not to collect
data during these two peaks, spanning 16:00 to 17:00 hours, and 20:00 to
21:00 hours.

The plot near the top of the display shows the number of satellites available at
any time during the selected time interval. Note that DOP peaks generally
occur when there are few satellites available (e.g. near 09:30 and 17:00
hours), but may also occur when more satellites are available, but the satellite
geometry is poor (e.g., near 21:00 hours).

3. Close the DOP Plot window by clicking on the close box.

Figure A.10. DOP Plot
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Using the Sky Plot
If you want to examine the satellite geometry for the survey interval, use the Sky
Plot window.

1. Select Sky Plot from the View menu to open the Sky Plot display (Figure
A.11).

This display is an overhead hemishpere showing the satellite status during
the specified time interval: the satellites available and their trajectories across
the sky. The numbers in the circles are the satellite designations. The cross-
hatch annular ring is the elevation mask, in this case 15 degrees, as indicated
by Cut 15 in the Status Bar.

Obstruction Editor

The obstruction editor lets you define obstructions near the active site;
obstructions such as large buildings or structures impair satellite visibility, and
increase the DOP value. Once obstructions have been defined for a site, they are
incorporated in any future calculations of satellite availability and dilution of
precision (DOP) for the site. Be aware that heavily obstructed sites (e.g., a street
between tall buildings) may not be suitable for GPS observations. After you define
the obstructions for a site, you can examine satellite availability and DOP to
determine if enough data can be collected at the site to accurately determine its
position.

Figure A.11. Sky Plot
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1. Select Obstruction from the Site List menu (or click Obstruct. in the Site
Editor dialog box) to open the Obstruction Editor dialog box, Figure A.12.

Use the Obstruction Editor dialog box to define obstructions, if any, at the
selected site. Obstructions can affect the DOP, and could make the collected
data unreliable. You must tell the software that an obstruction is present at the
site; knowing that an obstruction is present, the software can calculate the
effect of the obstruction on the DOP, then display the adjusted DOP in the
DOP plot.

The circle in the Obstruction Editor dialog box represents the upper
hemisphere of sky view at the site. The radial lines from the center represent
azimuth, and the concentric circles represent elevation from 0 to 90 degrees
in increments of ten degrees. To create an obstruction, you literally “draw” the
obstruction in terms of its azimuth and elevation.

2. Click within the circle to place the first point of the obstruction.

3. Click within the circle a second time to place the second point of the
obstruction.

4. Each additional point specified in the obstruction connects a line to the
previous point.

5. Continue specifying points until the obstruction shape has been defined.

Figure A.12. Obstruction Editor Dialog Box
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6. After outlining the obstruction shape, click Finish Obstruction to close the
obstruction shape from the last point to the first point. The Obstruction
Editor dialog box closes the obstruction shape using the shortest route .

• Use the Remove Last Line button to delete the last line drawn in the
obstruction shape. You can repeat this function for all lines in the
current obstruction shape.

• Click the Remove Obstruction button and then an obstruction line to
delete it.

• Use the Remove All button to delete all obstructions for the site.

7. Click in the DOP Plot and Sky Plot to update the windows.

Figure A.13. Drawing the Obstruction
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B

RINEX ConverteRINEX ConverteRINEX ConverteRINEX Converterrrr
RINEX (Receiver INdependent EXchange) is a standard format for GPS,
GLONASS, or GPS+GLONASS data supported throughout the industry.

The RINEX Converter utility provides a means to translate single or multiple
RINEX-formatted data files from any receiver to Ashtech-formatted files, and,
alternatively, convert Ashtech data files to RINEX format. RINEX Converter
supports RINEX format version 2.01.

Preliminary Operations

Before you perform any conversions, you must create four directories and do the
following preliminary operations in your computer to avoid confusion.

• Rinexin - Create this directory and load your RINEX files into it.
• Rinexout - Create this directory. Later, you will put your converted Rinex-

Ashtech files in this directory.
• Ashin - Create this directory and load your Ashtech files into it.
• Ashout - Create this directory. Later, you will put your converted Ashtech-

Rinex files in this directory.

The directory names listed above are suggestions; you can use whatever
directory names you prefer.
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Starting Rinex Converter

Select the Rinex Converter application in the Ashtech Solutions in the
Programs menu from the Start Bar.

-or-

Select RINEX Converter from the Tools menu.

The RINEX to Ashtech dialog box opens (Figure B.1).

Use this dialog box to select the files you want to convert, and define the
conversion options.

Table B.1 describes the fields in the RINEX to Ashtech dialog box.

Figure B.1. RINEX-to-Ashtech Dialog Box

Table B.1. RINEX to Ashtech Dialog Box Parameters

Item Description

File types Lists the file types: RINEX Observation files (*.*O), All files (*.*). RINEX NAV-
files*.*N, RINEX Nav g-files*.*G, RINEX Met-files *.*M. To select a file type, click the
down arrow D at the right end of the field and select file type from the list.

Available files
list

The white area below File Types. List of files in current directory. To select a file,
click on the file. To select multiple files, select the first file, hold down the Ctrl key,
and select additional files by clicking with the cursor.

Obs This field lists the file name of the observation data file corresponding to the selected
RINEX data file in the available files list.
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Nav This field lists the file name of the GPS navigation data file corresponding to the
selected RINEX data file in the available files list.

Navg This field lists the file name of the GLONASS navigation data file corresponding to
the selected RINEX data file in the available files list. The field is empty if GLONASS
data were not collected.

Met This field lists the file name of the Meteorological data file corresponding to the
selected RINEX data file in the available files list. The field is empty if meteorological
data were not collected.

BEGIN Click this button to begin converting the RINEX files to Ashtech format.

B-File This field lists the suggested file name for the output B-file (raw measurement data).

E-File This field lists the suggested file name for the output E-file (ephemeris data).

S-File This field lists the suggested file name for the output S-file.(site information). The
field is empty if site data were not entered into receiver.

Input dir Click this button to open the Set input directory dialog box. See next entry in this
table.

Set input
directory

This combo box lets you select the directory where the RINEX files are stored.

= Click this button to set the output directory the same as the input directory.

Output dir Click this button to open the Set output directory. See next entry in this table.

Set output
directory

Select the directory where converted data files will be stored.

Overwrite files Select the overwrite options: Prompt for Overwrite, Always overwrite, or Never
overwrite. To select an overwrite option, click the down arrow at the right end of the
field and select an overwrite option from the list presented.

GPS Click this box if GPS data will be used in conversion. This option is on by default.

GLONASS Click this box if GLONASS data will be used in conversion (on by default). You will
have GLONASS data only if your receiver is capable of receiving GLONASS signals.

B-File Click this box to create a B-file (position data) when converting RINEX files.

E-File Click this box to create a E-file (ephemeris data) when converting RINEX files.

S-File Click this box to create a S-file (site information) when converting RINEX files. The
S-file is created only if site data is included in the RINEX file.

Free Space This field displays the available disk drive space for the selected output directory.

Exit Closes RINEX Converter.

About Displays software version number.

Help Opens on-line help system.

Table B.1. RINEX to Ashtech Dialog Box Parameters (continued)

Item Description
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Converting RINEX to Ashtech Format

Rinex files from any GPS receiver can be converted to Ashtech format for post-
processing. The following procedure specifies how to convert RINEX data files to
Ashtech format.

1. In the RINEX to Ashtech dialog box, click Input dir to open the Set input
directory dialog box (Figure B.2).

2. Using standard Windows file navigation procedure, navigate to the directory
where the RINEX input files are located and then click Save.

If you are converting RINEX files translated from a RINEX converter that does not use the standard
RINEX naming format, the observation files may not have the format *.*O. If the files are not listed in
the Available Files list, change the File Types to All Files on the Rinex to Ashtech tab and All Files in
the Input Directory.

3. The Set Input directory dialog box closes. The Input Directory list lists the
directory path, and the Available Files list lists the RINEX files in the input
directory (Figure B.3).

Figure B.2. Set Input Directory Dialog Box
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Depending upon the type of file (i.e. Obs or Nav), the OBS, NAV, B-File and
E-File fields populate with suggested file names. Nav g, Met, and S-file
names may also appear if the information is contained in the Rinex file.

4. Click Output dir to open the Set Output directory dialog box (Figure B.4).

5. Using standard Windows navigation procedure, navigate to the directory
where you want to store the converted files, and then click Save.

To avoid confusion, save the converted Ashtech files to a directory different than where the RINEX
files are located.

The Output Directory list lists the directory path.

Figure B.3. Rinex-to-Ashtech Dialog Box with Suggested Output File Names

Figure B.4. Set Output Directory Dialog Box
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To avoid confusion, do not change the suggested file names. To restore the original suggested
output file name, double-click the filename in the available files list.

6. Select the Overwrite files option by clicking the arrow to the right of the
Overwrite files list, and selecting an option from the list. There are three
overwrite options:

• Prompt for Overwrite - (Default setting). If RINEX Converter detects
that a converted file has the same name as an existing file, meaning
the new file will overwrite the existing file, a dialog box asks if you wish
to overwrite the existing file. If you click NO, RINEX Converter skips
the file, and continues to the next file.

• Always Overwrite - This option always writes over existing files with a
new file.

• Never Overwrite - This option does not overwrite data for a given file
if a file with the same name already exists.

By default, RINEX Converter assumes that the RINEX files use both GPS and
GLONASS (Nav g) data; however, there is no Nav g file unless a GLONASS
receiver was used to collect data.

By default, RINEX Converter creates a B-File (GPS position data), an E-File
(satellite ephemeris), and an S-File (site parameters, if recorded) in Ashtech
format. If you do not want one or more of these file types created, click the
corresponding check boxes to remove the check mark. Be aware that the S-
file is not created unless the site information is recorded in the receiver file.

7. Click BEGIN to convert the selected RINEX files to Ashtech format. The
Conversion status dialog box opens (Figure B.5).

Figure B.5. Conversion Status Dialog Box
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8. The Conversion status dialog box shows the status of each file as it is
converted. Upon completion, the display indicates 100% for each file, or 0 if a
file were not converted for lack of data, e.g. GLONASS data, as noted above.

• Click Cancel to cancel the conversion to the current file type and
proceed to the next file type.

• Click Cancel All to cancel the entire conversion.

9. A *.log file is created in the directory containing all conversion activity. When
restarted, RINEX converter overwrites the existing log file. To save the old log
file, rename or move the file before restarting RINEX Converter.

The selected RINEX files are now in Ashtech format and can be used with data
files from Ashtech receivers for post-processing.

Converting Ashtech Files to RINEX Format

RINEX Converter can convert Ashtech files from any GPS or GPS+GLONASS
receiver into RINEX format. The following procedure describes how to convert
Ashtech files to RINEX format.

1. Click the Ashtech to RINEX tab to switch to the Ashtech to Rinex tab
(Figure B.6).

Figure B.6. Ashtech to Rinex Dialog Box
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Table B.2 describes the fields in the Ashtech to RINEX dialog box.

Table B.2. Ashtech to RINEX Dialog Box Fields

Item Description

File Types Lists the files types: Ashtech B-Files (B*.*), Ashtech E-files
(E*.*), Ashtech S-files (S*.*) or All files (*.*). To select a file
type, click the arrow to the right of the field and select file
type from the list presented.

Available files list This is the white area below File Types. Lists files in current
directory. To select a file, click on the file. To select multiple
files, select the first file and then hold the Ctrl key while
selecting additional files with the cursor.

B-File This field lists the file name of the B-File corresponding to
the selected Ashtech data file in the available files list.

E-File This field lists the file name of the E-File corresponding to
the selected Ashtech data file in the available files list.

S-File This field lists the file name of the S-File corresponding to
the selected Ashtech data file in the available files list.

BEGIN Button Click this button to open the Conversion Status dialog box
and begin converting the Ashtech files to RINEX file format.

Obs This field lists the suggested file name for the converted
observation data file.

Nav This field lists the suggested file name for the converted
navigation data file.

Navg This field lists the suggested file name for the converted
GLONASS navigation data file.

Met This field lists the suggested file name for the converted
meteorological data file.

Input dir Click this button to open the Set input directory dialog box.
See next entry in this table.

Set input directory This combo box lets you select the directory where the con-
verted files will be stored.

= Click this button to set the output directory the same as the
input directory.

Output dir Click this button to open the Set output directory dialog
box. See next entry in this table.

Set output directory This combo box displays the directory path where converted
RINEX files are stored.
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Overwrite files Select the overwrite options: Prompt for overwrite, Always
overwrite, or Never overwrite. To select an overwrite option,
click the arrow D at the right end of the field and select an
overwrite option from the list presented.

GPS Click this box if GPS data will be used in conversion. This
option is on by default.

GLONASS Click this box if GLONASS data will be used in conversion
(on by default). There will be no GLONASS data unless a
GLONASS receiver was used to collect data.

Obs Click this box to create an observation file when converting
to RINEX.

Nav Click this box to create a navigation file when converting to
RINEX files.

Navg Click this box to create a GLONASS navigation file when
converting to RINEX.

Met Click this box to create a meteorological file when convert-
ing to RINEX. Will be created only if meteorological data
available.

Free Space This field displays the disk drive space available for the
selected output directory.

Exit Close RINEX Converter.

About Opens the dialog box which displays the software version
number.

Help Opens the on-line help system.

Table B.2. Ashtech to RINEX Dialog Box Fields (continued)

Item Description
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2. Click Input dir to open the Set input directory dialog box (Figure B.7).

3. Using standard Windows navigation procedure, navigate to the directory that
contains the Ashtech files you wish to convert.

4. Click Save to accept the directory and close the Set Input Directory dialog
box.

5. The Input Directory lists the directory path, and Available Files list lists the
Rinex files in the input directory (Figure B.8).

Figure B.7. Set Input Directory Dialog Box

Figure B.8. Ashtech Files in Selected Ashtech Input Directory
140 Ashtech Solutions User’s Guide



R
IN

E
X

C
o

n
verter

synergy.book Page 141 Wednesday, February 14, 2001 8:19 PM
6. Select the file(s) you wish to convert to RINEX in the Available Files list.

You can select multiple files by holding down the Ctrl key while selecting files
with the cursor and clicking the mouse button.

After selecting a file(s) to convert, the B-File, E-File, S-File, OBS, NAV,
NAVG, and MET fields, as applicable to the data in the file, populate with
suggested file names. If you selected multiple files, the filenames listed are
associated with the last file selected.

To avoid confusion, do not change the file names.

7. Click Output dir to open the Set output directory dialog box (Figure B.9).

8. Using standard Windows navigation procedure, navigate to the directory
where you want to store the converted files.

To avoid confusion, save the converted Ashtech files to a different directory than where the RINEX
files are located.

9. Click Save to accept the directory and return to the Set input directory dialog
box.

The Output Directory field lists the directory path.

Figure B.9. Set Output Directory Dialog Box
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10. Click Additional Info to open the Additional info for selected files dialog
box to the OBS Tab (Figure B.10).

The information listed in these tabs are stored in RINEX files to give you
reference information about the data. Although this additional information is
optional, it provides a useful reference for future use.

11. Complete the fields in the OBS Tab. The information entered in the OBS
dialog box is stored in the observation data file. Table B.3 describes each
field.

[

Figure B.10. Additional Info for Selected Files Dialog Box - OBS Tab

Table B.3. Additional Info for Selected Files Dialog Box - OBS Tab

Field Description

STATION INFORMATION

Station Name Name of the survey point or station where data was collected.

Station Number Number of the survey point or station where data was col-
lected.

Observer Name or code of the surveyor who collected the data.

AGENCY (Observing) Name of the company or agency who collected the data.

AGENCY (Creating Current
File)

Name of the company or agency who converted the data to
RINEX.

Comments Any comments pertaining to the station, data quality, cover,
GPS/GLONASS, etc. 50-character length limit.
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12. Click Apply to save the changes made to the OBS tab, and click Nav to
switch to the Nav tab (Figure B.11).

You can enter information for all three tabs and save all the data using the Save button. The best
practice, however, is to save the data using the Apply button for each tab immediately after entering
the data in case of a computer or power failure.

RECEIVER INFORMATION

Receiver Serial # Serial number of the receiver that collected the data.

All Optional Headers Check this box if you want all non-mandatory fields to be filled
in the RINEX file header.

ANTENNA INFORMATION

Offsets north (m) Horizontal distance, in meters, that the antenna is offset from
the marker in the north/south direction. + is north, - is south.

Offsets East (m) Horizontal distance, in meters, that the antenna is offset from
the marker in the east/west direction. + is east, - is west.

Delta Vertical (m) True vertical distance, in meters, between the bottom of
antenna and the marker.

Radius (m) Radius of the antenna in meters.

Slant Distance (m) Measured distance, in meters, from the edge of the antenna
to the marker. If a value for an antenna are entered, it over-
writes the values in the S-file.

Type Type of antenna used in data collection.

Serial # Serial number of antenna used for data collection.

Table B.3. Additional Info for Selected Files Dialog Box - OBS Tab (continued)

Field Description
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The Save button saves the data entered on the active tab only, and closes the Additional info for
Selected Files dialog box.

13. Complete the fields in the NAV dialog box. The information entered in the
NAV dialog box is stored in the navigation data file. Table B.4 describes each
field.

Figure B.11. Additional Info for Selected Files Dialog Box - NAV Tab

Table B.4. Additional Info for Selected Files Dialog Box - NAV Tab

Field Description

Agency (Creating Current File) Name of the company or agency who converted the
data to RINEX.

Comments Any comments pertaining to the station, data quality,
cover, GPS/GLONASS, etc. 50-characters maximum.
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14. Click Apply to save the changes made to the NAV dialog box, and click on
the MET tab to switch to the MET tab (Figure B.12).

15. Complete the fields in the MET dialog box. The information entered in the
MET dialog box is stored in the meteorological data file. Table B.5 describes
each field.

Figure B.12. Additional Info for Selected Files Dialog Box - MET Tab

Table B.5. Additional Info for Selected Files Dialog Box - MET Tab

Field Description

Station Name Name of the survey point or station where data was collected.

Agency (Creating Current
File)

Name of the company or agency that converted the data to
RINEX.

Comments Any comments pertaining to the station, data quality, cover,
GPS/GLONASS, etc. 50-character limit.

Meteorological Data List Date and time atmospheric data was collected (atmospheric
pressure, temperature, relative humidity, and ZWET (Zenith
Wet Tropospheric Delay).

Edit Click this button to open the Edit dialog box and edit the
selected meteorological data line.
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16. Click Edit to open the Edit dialog box (Figure B.13) and inspect or change the
meteorological data.

17. Enter the meteorological data, the date and the UTC time that the data was
taken, and click OK. Table B.6 describes the fields in the Edit dialog box.

18. Click OK to accept the meteorological data and close the Edit dialog box.

Figure B.13. Edit Dialog Box

Table B.6. Edit Dialog Box Parameters

Field Description

Date The year, month, and date that the data was recorded. D is the day of the
month (not Julian day) the data was recorded.

Time The time the data was recorded. H is the hour of the day the data was
recorded in UTC time (24 hour time scale) M is the minute of the hour the
data was recorded in UTC time. S is the second of the minute the data was
recorded in UTC time

Pressure (mbs) The recorded barometric pressure of the atmosphere in millibars.

Dry Temp (C) The recorded temperature of the air not corrected for humidity, in degrees
Celsius.

Rel. Hum (%) The recorded relative humidity of the air in percent.

ZWET (mm) Zenith Wet Tropospheric Delay—in millimeters (default = 0)
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19. Click Save to save the changes made to the Met tab and close the
Additional info for selected files dialog box.

• The Apply button saves any changes made to the active tab, and
does not close the Additional info for selected files dialog box.

• The Save button saves any changes made any tab, and closes the
Additional info for selected files dialog box.

20. Click Begin to convert the selected Ashtech files to RINEX format. The
Conversion Status dialog box opens (Figure B.14), showing the status of the
conversion process. Upon completion, the dialog box indicates 100% for each
file.

21. Click OK.

A *.log file is created in the conversion directory. When started, RINEX
converter overwrites the previous *.log file. To save the previous *.log file,
rename or move the file before starting RINEX converter.

Converting More than One File at a Time (Batch Processing)
To convert more than one file at a time:

• If the files are contiguous, hold down the Shift key, select files with the
cursor, and click each file.

• If the files are scattered throughout the directory, hold down the Ctrl key,
select files with the cursor, and click each file.

Figure B.14. Conversion Status Dialog Box
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Post-Adjustment AnalysiPost-Adjustment AnalysiPost-Adjustment AnalysiPost-Adjustment Analysissss
A least-squares adjustment of survey observations is one of the most important
steps in a GPS survey. Properly used, a least-squares adjustment helps isolate
blunders in the observations being adjusted and improves the accuracy and
reliability of the point positions being determined. The mathematics and statistics
involved in performing and analyzing a least-squares adjustment is somewhat
complex but the basic concepts of the task accomplished by an adjustment are
straight forward.

The primary components of a least-squares adjustment are the survey
observations (angles, distances, elevation differences, and, in this case, GPS
vectors) and the uncertainties (confidence) associated with these observations.
Due to measurement limitations of the surveying instruments and the influence of
the instrument operators, these observations include some level of error. These
errors cause loops not to close perfectly and result in the ability to compute
different positions for the same point in the network based on which observations
were used to compute the position.

The ultimate goal of a least-squares adjustment is to produce a set of
observations where all loops close perfectly and only one position can be
computed for any point in the network. In order to accomplish this task, the
observations going into the adjustment must be changed slightly, i.e. adjusted. Of
course, you do not want the observations to be changed much since this it what
was physically observed in the field, but the observations do contain some level of
error. Any error associated with an observation is predictable because of the
measurement accuracy of the survey instruments used. So, do not be concerned
that the observations are adjusted as long as the amount of adjustment to any
given observation is not significantly greater than the expected error in the
observation. These are the fundamental guidelines to a least-squares adjustment.
A successful adjustment is one where observations are changes as little as
possible, and the amount of change (adjustment) to any observation is within
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expected levels, i.e. about the same magnitude as the uncertainty in the
observation.

Unfortunately, there are a number of obstacles that can stand in the way of
producing a successful adjustment. Primary on this list are blunders, errors in the
observations due to equipment malfunction or operator error. Examples are an
incorrectly measured instrument height, an instrument not properly centered over
the survey mark, insufficient data to produce a high quality GPS vector, assigning
the wrong Site ID to a point, etc. The list is long. Fortunately, tools exist to assist in
overcoming these obstacles. These adjustment analysis tools have been
incorporated into the adjustment module of Ashtech Solutions.

The adjustment analysis tools fall into two main categories, blunder detection
tools and quality analysis tools. Each of these tools is explained in detail below.
The explanation includes how the tool works, the purpose of each tool, and when
to use each tool.

After discussion of the available analysis tools, there is a section describing the
process of analyzing an adjustment. From start to finish, each step of the analysis
process is listed showing the sequence of when and how to use the analysis
tools.

Before proceeding, there are few things you must remember when analyzing an
adjustment with this tool set.

1. Many of the analysis tools are statistically based. These statistically based
tools utilize the GPS vector uncertainties (error estimates) as the basis for
their testing. It is critical the observation uncertainties are realistic for the
statistically based tools to function properly. Unrealistic uncertainties will
cause the analysis tools to function unpredictably and, in the worst case, may
make a bad adjustment look good.

The vector-processing module is responsible for assigning uncertainties to
the processed GPS vectors. A great deal of effort has gone into insuring that
realistic uncertainties are determined. Unfortunately, this is not always an
easy task and at times, the uncertainties may be a little optimistic (too small)
or pessimistic (too large). Recognizing this, methods were developed to help
identify when uncertainties are unrealistic and to help rectify this situation.
These methods are explained in detail below.

2. Adjustment analysis tools cannot function properly without redundancy in the
adjusted observations. It is impossible to detect a blunder in an observation
establishing the position of a point if there is only one observation at this
point. When designing a survey network, be sure to include sufficient
redundancy in the observations. The best case would be to include more than
one observation of each point being established. Unfortunately, this is not
practical and really not necessary. Select a certain percentage of points to
receive multiple observations. Thirty to fifty percent is recommended. This
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redundancy will significantly increase the likelihood that observation blunders
will be detected by the adjustment.

In the discussion of the analysis tools below, it is assumed that sufficient
redundancy exists in the adjusted observations.

3. It is also important to remember that no analysis tool gives a definitive
indication of the existence of blunders or the quality of an adjustment. No one
tool should ever be solely relied upon. All tools must be used together for an
effective analysis of an adjustment.

4. Blunder detection should always be performed on minimally constrained
adjustments. Attempting to detect blunders in a constrained adjustment is
very difficult since a detected problem can either be caused by a blunder or a
error in the control position fixed in the adjustment. The first step in the
adjustment process should always be a minimally constrained adjustment.
Use this adjustment to detect and eliminate blunders from the data set, and
determine the internal quality of the survey data. After the data set is clean of
blunders and it is determined that the survey meets the relative accuracy
specification, a constrained adjustment can be performed.

In the discussion of blunder detection tools below, it is assumed that the tools
are being used on a minimally constrained adjustment.

Blunder Detection Tools

The blunder detection tools are designed to assist you in detecting problems with
an adjustment. The tools assist in determining if blunders exist in any of the
observations used in the adjustment, or if any problems exist in the network
construction that would hamper the ability for an adjustment to be performed.
Each tool is presented in detail below.

Network Connectivity Test
In order to properly adjust an entire data set of observations, there must be
connectivity between all sections of the data set. For example, look at a survey of
a pipeline that will require multiple days of work to complete. Two survey crews
begin work on the project, one on the north end and one on the south end. At the
end of day 1, each crew will have a surveyed a number of points at each end of
the project. The two data sets have no observations between them yet. These two
data sets cannot be adjusted together because they are not connected.

The network connectivity test examines the data set prior to adjustment to
determine if there are subsets of the data set that are not connected by
observations.
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Variance of Unit Weight/Standard Error of Unit Weight
The Variance of Unit Weight and the Standard Error of Unit Weight (the square-
root of the Variance of Unit Weight) monitor the relationship between the
uncertainties assigned with the observations and the magnitude of the change
required to each observation (residuals) in the adjustment. Changes to the
observations should be small and should not be significantly greater than the
uncertainties associated with the observations.

The Variance of Unit Weight and Standard Error of Unit Weight gauge the
magnitude of the observation changes (residuals) compared to the observation
uncertainties for the entire network. Analysis of the magnitude of the computed
Variance of Unit Weight and Standard Error of Unit Weight reveals one of the
following three conditions regarding the quality of the adjustment:

1. A computed value close to 1 is an indication that the changes to the
observations (residuals) are within expected levels, i.e. within the
uncertainties associated with the observations. Since this is the desired
outcome, a value close to 1 is normally an indication of a good adjustment.

2. A computed value significantly smaller than 1 indicates an imbalance
between the observation residuals (changes) and observation uncertainties.
Specifically, the observation uncertainties are too pessimistic (too large).

3. A computed value significantly larger than 1 is also an indication of an
imbalance between the observation residuals (changes) and observation
uncertainties. Specifically, one of two problems exist with the adjustment.
Either one or more blunders exist in the observations causing the observation
residuals to be much larger than the observation uncertainties, or the
observation uncertainties are too optimistic (too small).

To fully comprehend the significance of a Standard Error of Unit Weight being
significantly smaller or larger than 1, it is first imperative that any observation
blunders that may exist in the observations be removed from the adjustment.
Later in this chapter you will find additional tools that are specifically designed to
isolate blunders. With the absence of blunders in the network observations, the
magnitude of the Standard Error of Unit Weight can be examined to determine its
significance. In a blunder free adjustment, the magnitude of the Standard Error of
Unit Weight the magnitude of the disagreement between the uncertainties
associated with the observations and what the adjustment determines should be
the observation uncertainties.

For example, if the Standard Error of Unit Weight is computed to be 2 and the
adjustment is blunder free, the adjustment had determined, based on the size of
the observation residuals, that the observation uncertainties should be 2 times
larger than they are currently stated to be. If the computed Standard Error of Unit
Weight is 0.5, then the observation uncertainties should be 2 time smaller than
they are currently stated to be. Why is this important? For two reasons:
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1. Many of the tools used to analyze the quality of the adjustment are statistically
based. For them to work properly, the observation uncertainties going into the
adjustment must be realistic, i.e. close to the real uncertainties. The Standard
Error of Unit Weight computed from a blunder free adjustment gives an
indication of the quality of the observation uncertainties. If the Standard Error
of Unit Weight is much greater than or smaller than 1, this is an indication that
the observation uncertainties are not realistic. Fortunately, Ashtech Solutions
automatically compensates for this problem. All post-adjustment statistics
used to measure the quality of the adjustment utilize the computed value for
the Standard Error of Unit Weight to automatically compensate for unrealistic
uncertainties. No action on the part of the user is required.

2. A great deal of effort went into ensuring that the vector processing of Ashtech
Solutions assigned realistic uncertainties to the processed vectors. But since
this is not yet an exact science, there are conditions that may cause the
computed uncertainties to be too small or too large. In most cases, you should
find that the computed Standard Error of Unit Weight falls between 1 and 3. In
addition, you should find that this value is relatively consistent for similar types
of surveys. If you find that for most of your surveys, the Standard Error of Unit
Weight for a blunder free adjustment is 1.5 and today you are working on an
adjustment with a Standard Error of Unit Weight of 6, there probably is
something wrong with the adjustment.

Chi-Square Test
The Chi-Square test is a statistical test evaluating the computed value for the
Variance of Unit Weight. Its purpose is to determine if the computed value for the
Variance of Unit Weight is statistically equivalent to 1. As stated earlier, a Variance
of Unit Weight equal to 1 indicates a balance between observation residuals and
observation uncertainties. It is very seldom that the computed value for the
Variance of Unit Weight will exactly equal 1. But an exact value of 1 is not
required. The Chi-Square test examines the computed value to determine if it is
statistically equivalent to 1. If the test passes, the computed value is considered
equivalent to 1.

Due to the difficulties in computing observation uncertainties due to the many
variables involved, in many cases the Variance of Unit Weight will be larger or
smaller than 1. This causes the Chi-Square test to fail. Ashtech Solutions
automatically compensates for observation uncertainties being too large or too
small, therefore the passing or failure of the Chi-Square test has no true bearing
on the quality of the adjustment. If, by using the other blunder detection tools
available, you are confident that all blunders have been removed from the
adjustment and you are happy with the relative size of the observation residuals,
then a failure of the Chi-Square test should not be a concern. The Chi-Square test
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can be made to pass, if desired, by scaling the observation uncertainties using the
Processed vector error scaling factor found in the Miscellaneous tab of the
Project Settings dialog box. Scale the vector uncertainties by the computed
Standard Error of Unit Weight.

Observation Residuals
In a least-squares adjustment, small corrections are applied to the observations to
obtain the best fit of all observations producing one solution for all points. The
best fit is the solution that produces the least amount of corrections to the
observations. These small corrections are termed residuals. Each observation will
have one or more residuals. GPS observations have three residuals, one for each
component of the GPS vector (X,Y,Z or N,E,U).

The reason that observations have to be corrected at all in order to produce a
good fit is due to errors in the observations. If observations contained no errors,
than an adjustment would not be needed. All observations would fit together
perfectly. Two types of errors can be found in survey observations, random errors
and blunders. Random errors will cause small corrections to be needed in
observations in order to make them fit together properly. If only random errors
exist in the data set, all residuals will likely be small. On the other hand, if large
blunders exist in the data set, large residuals will likely be produced.

Examining the size of observation residuals can help in identifying blunders in the
observations used in the adjustment. Ashtech Solutions will display and output
the residuals for all observations. These residuals should be examined in an
attempt to identify blunders. If blunders are identified, they must be removed from
the data set, and the adjustment rerun. If the observation containing the blunder is
a critical observation of the data set, it should be examined to determine the
cause of the blunder. Once repaired, the observation can be returned to the
adjustment. If the observation is critical to the strength of the network and cannot
be repaired, the data will need to be re-observed.

There are two main difficulties in using residuals to identify blunders in a data set.

1. Blunders, if large enough, will produce large residuals for the observation
containing the blunder. But large residuals do not always indicate a blunder, in
an observation. It is possible for a good observation to have large residuals.
This obviously complicates the use of residuals to find blunders but this
obstacle can be overcome with the understanding of why a good observation
will produce large residuals.

A least-squares adjustment tends to distribute the effects of blunders
throughout the entire network. In other words, a blunder in one observation
usually affects the residuals in other observations. The affect is greater on
observations closer to the blunder and diminishes further out. The trick is to
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find the observation with the blunder among all the observations containing
large residuals due to the blunder.

In most cases, the observation with the largest residuals is the observation
containing the blunder. Remove this observation and rerun the adjustment. If
all residuals look good at this point, the blunder was identified and removed. If
large residuals still exist, again remove the observation with the largest
residuals and rerun the adjustment. Do this until the adjustment looks good. It
is possible that some of the observations removed do not contain blunders. At
this time, each observation removed should be added back to the adjustment
one at a time, rerunning the adjustment each time an observation is added. If
the adjustment looks good, that particular observation did not contain a
blunder. If the adjustment looks bad after adding back one of the
observations, the chances are very good that the observation contains a
blunder.

This process can be complicated even further if multiple blunders exist in the
data set. But systematic removal and replacement of observations will result
in identifying the blunders.

2. Throughout this section, we have talked about large residuals and their roll in
identifying blunders. A natural question is 'What is a large residual?'.
Unfortunately, there is no easy answer to this question. For GPS vectors,
random errors in the observations increase as the length of the vector
increases. Therefore, residuals will increase with baseline length. A residual
of 0.10 meters on a 20-kilometer line may solely be due to random errors but
the same residual on a 2-kilometer line almost surely indicates a blunder. So,
a residual being large or small is dependent on the GPS vector length.

There are a few guidelines that can be used to help examine residuals. First,
all vectors of similar length should have similar residuals. Second, residuals
should not be much greater than the measurement accuracy of the
equipment. For example, if the equipment being used is capable of making
observations at an accuracy level of 0.01m + 2ppm, the residuals for an
observations should not be much greater than this capability. An accuracy
specification of 0.01m + 2ppm allows for an error of 0.03m on a 10 kilometer
baseline. A residual 2-3 times larger than this allowable error is suspect and
should be examined closely for the possible presence of a blunder.

Sometimes the size of a residual will be border line as to whether or not a
blunder exists. If this is the case, the observation should be inspected closely
to see if the cause of the blunder can be determined. If not, it is a judgement
call as to whether or not the observation should be removed. If the
observation is not critical to the strength of the network, it can be removed
without impact. If the observation is needed but does not seem to have an
adverse affect on the accuracy of the adjusted points, it can be left in.
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The program presents residuals in two forms. You can examine the size of the
residual in linear units (meters or feet) as discussed above, or you can examine
normalized residuals. Normalized residuals take into account that residuals
generated by random errors are somewhat predictable statistically. Normalized
residuals are unitless scaled values of the actual residual. Evaluation of the
normalized residuals will reveal one of three things:

1. A value of 1 indicates that the residual is as large as expected based on its
standard error. This is usually an indication that the observation contains no
blunders.

2. A value of less than 1 indicates that the residual is smaller than expected.
This also is usually an indication that the observation contains no blunders.

3. A value greater than 1 indicates that the residual is larger than expected. For
example, a value of 2 indicates the residual is 2 times larger than expected,
and a value of 3 indicates that the residual is 3 times larger than expected.

Since residuals are expected to be normally distributed, approximately 68%
of residuals caused by random errors should only have a normalized value of
1 or less, approximately 95% should be 2 or less, and approximately 99%
should be 3 or less. Therefore, a normalized residual greater than 3 is either
one of the 1% that is caused by random errors (good residual) or represents
an observation containing a blunder.

Since there is such a small chance that a normalized residual greater than 3
belongs to a good observation, any normalized residual greater than 3 should
be suspect and examined as being a potential blunder.

The normalized residual is an alternative to looking at the size of the residual to
determine if the residual belongs to an observation that contains a blunder. In
some aspects, the normalized residual is easier to evaluate since vector length is
compensated in the scaling of the residual. A value greater than 3 should be
suspect, independent on the length of the vector.

In summary, use observation residuals to help identify blunders in the adjustment
data set.

• If all residuals are small or if the normalized residual is less than 3, this is a
good indication that no blunders exist.

• If large residuals are found or normalized residuals greater than 3,
blunders may exist in the data set. Remove the observation with the
largest residuals or normalized residuals and rerun the adjustment.
Repeat this one observation at a time until the residuals for the remaining
observations look good. Since good observations may have been
removed in this process, add each observation back into the network one
at a time, and examine its affect on the adjustment. Those observations
156 Ashtech Solutions User’s Guide



Post-Adjustm
entAnalysis

synergy.book Page 157 Wednesday, February 14, 2001 8:19 PM
returned to the network that do not adversely affect the adjustment should
be left in.

• Closely examine any observation that has been removed to determine if
the cause of the blunder can be determined. If yes, fix the blunder and
return the observation to the adjustment.

• Be aware that these are only guidelines to finding blunders. Do not remove
an observation from the adjustment just because the normalized residual
is 4 or 5 or the residuals look large. This could represent a good
observation. Look at other quality indicators to determine if there is a
problem in the adjustment. Remove the observation and see what the
effect is on the adjustment. If there is no great affect on other observations
or position estimates, put the observation back. The more good
observations in the data set, the better the final solution.

Tau Test
Examining residuals is a good indicator of the quality of individual observations.
As stated earlier, the expected value of residuals/normalized residuals are
predictable since they are expected to follow a normal distribution.

The tau test utilizes this predictability to automatically test the residuals of an
observation to determine if the residuals could represent an observation
containing a blunder. The tau test utilizes the normalized residuals for an
observation to determine if statistically the residual is within expected limits. A
threshold value is computed to test each normalized residual against. Each
normalized residual is tested with two possible outcomes:

• The tau test passes indicating that the magnitude of the normalized
residual is not greater than the expected limit for the residual. This is
usually a good indication that the observation is free of blunders.

• The tau test fails indicating that the magnitude of the normalized residual
is greater than expected. The observation failing the test should be
checked for blunders.

The tau test is automatically performed by the adjustment module of Ashtech
Solutions. Each residual is tested and the outcome of the test is presented along
with the residuals for each observation.

It is important to understand, that if a residual does not pass a statistical test, it
does not mean that there is a blunder in that observation. The observation is
merely flagged so that it can be examined and a decision about its retention or
rejection can be made. Blind rejection is never recommended. A blunder in one
observation usually affects the residuals in other observations. Therefore, the
tests will often flag other observations in addition to the ones containing blunders.
If one or more observations are flagged, the search begins to determine if there is
a blunder.
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In summary, the tau test examines observation residuals in an attempt to locate
observations that may contain blunders. Each residual is tested to determine if it
passes or fails the test.

• If a residual passes the tau test, this is a good indicator that the
observation does not contain blunders.

• If the residual fails the tau test, the observation should be closely
examined to determine if it contains a blunder.

• Remember that if a residual fails the tau test, this is not a certain indicator
that a blunder exists. Simply removing observations that have failed the
tau test is not recommended. These observations must be examined
carefully to determine if a blunder exists.

Loop Closure Analysis
In a well designed survey network, a number of closed loops, generated by GPS
vectors, will exist. If all observations contained zero error, performing loop
closures with various vectors throughout the network would result in loops with
zero misclosure. Since in the real world, absolutely perfect survey observations
are impossible, loops will generate some level of misclosure. Misclosures due to
random errors in the observations should be of predictable magnitude, i.e. a
magnitude similar to the measurement accuracy of the instrument used.
Misclosures due to blunders are unpredictable in magnitude, ranging in size
based on the size of the blunder. Due to this, loop closures can be an effective
method to isolate blunders in the data set.

When a large blunder or multiple blunders exist in a data set, it is sometimes
difficult to find the blunder(s) from analysis of the adjustment output. This is due to
the tendency of least-squares adjustments to distribute the error from these
blunders throughout the survey network. In such cases, loop closures can be an
effective tool to assist in isolating the blunders. By performing multiple loop
closures in the area where a blunder(s) is suspected to exist, the vector(s)
causing the blunder(s) can normally be isolated. Once the problem vector(s) is
isolated, it can be examined and repaired or removed.

Ashtech Solutions supplies the tools for you to perform a loop closure analysis of
the survey network to assist in isolating blunders. By selecting vectors, you can
create multiple loops throughout the network. The results of each loop closure are
presented for analysis. In addition, the resulting closure is compared to you
defined relative accuracy specification as a quality test of the closure.

• If the misclosure is smaller than the allowable error determined from the
specification, the QA test passes. This may be an indication that no
blunders exist in the vectors used in the loop. This would not be true if the
blunder is the kind that would not be found based on the vectors used in
the test. For example, if a blunder of 0.5 meters existed in the HI
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measurement at a point, all vectors observed during that session would
contain the blunder. Therefore, if a loop closure were performed using
these vectors, the blunder would not be found. On the other hand,
suppose that same point was observed at another time producing a
different set of vectors going into the point. If a loop was performed using a
combination of the vectors from the two observation periods, this blunder
would be detected.

• If the misclosure is larger than the allowable error determined from the
specification, the loop fails the QA test. Flagged loops should be examined
closely to determine if a blunder exists in one of the vectors used in the
loop.

Repeat Vector Analysis
When performing a GPS survey, it is recommended that a certain percentage of
observed vectors be repeated, i.e. observed more than once. These repeat
vectors can be used to analyze the repeatability of the observations, giving a clue
to the overall quality of the final survey. In addition, repeat observations can be
useful in identifying blunders if a problem arises with one of the repeated
observations.

Ashtech Solutions automatically performs an analysis of all repeat vectors in the
network. All repeat vectors are compared to each other and differences in the
observations are presented for analysis. In addition, the resulting differences
between repeat observations are compared to the user-defined relative accuracy
specification.

• If the difference between the repeat observations of a vector is smaller
than the allowable error computed from the accuracy specification, the
repeat vectors pass the QA test. This is normally a good indication that no
blunder exists in the vectors, and that the vectors are of sufficient quality to
produce a network that will meet the desired relative accuracy.

• If the difference between the repeat observations of a vector is larger than
the allowable error computed from the accuracy specification, the repeat
vectors are flagged as having failed the QA analysis test. Any repeat
observations that fail the test should be examined closely to determine if a
blunder exists.

Control Tie Analysis
For many surveys, there is a requirement to tie the survey into a local, regional, or
national control network. Many times, the exact control points to be used for this
purpose will be specified. To meet this requirement, these control points will need
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to be held fixed in the final constrained adjustment, therefore computing positions
for the new survey points in relation to the specified control points.

In addition to the requirement for tying into a control network, most surveys will
also have a relative accuracy specification that must be met. Under certain
circumstances, these two requirements may conflict with each other. If the relative
accuracy of the control points held fixed in the constrained adjustment is not
greater than or equal to the relative accuracy specification of the survey, there is
no hope to meet the relative accuracy specification by holding these control points
fixed. The error in the relationship between the control points will, when held fixed
in the constrained adjustment, induce this error into the survey network being
adjusted, degrading the accuracy of the network to the relative accuracy of the
control. For example, if after performing a minimal constraint adjustment, the
relative accuracy of the survey is found to be 1:250,000, and if a constrained
adjustment is performed holding fixed control points with a relative accuracy of
only 1:90,000, the highest possible resulting network accuracy will be 1:90,000. If
the relative accuracy specification for the survey was 1:100,000, the survey no
longer meets the requirement. This, of course, is of no fault of the surveyor. The
surveyor conducted a survey that has an internal relative accuracy of 1:250,000.
The control points specified in the requirements are the cause of the degradation
in the accuracy. At this point, the surveyor should inform the client of the issue. It
then becomes the client's responsibility to determine if these control points are
held fixed at the cost of the network relative accuracy.

In a situation where multiple control points have been specified for use in the
survey, it is possible that only one of the control points is responsible for the
degradation. It is possible that only one of the control points has a relative
accuracy of 1:90,000 compared to the other points, and that the other control
points tie to an accuracy that would support the relative accuracy specification. In
such a case, it would be useful to know which point is causing the problem. This
way, if allowed by the client, this point could be disregarded and a final
constrained adjustment could be performed using the remaining control points. To
do this, you would have to compute the relative accuracy between all control
points in the survey.

The control tie analysis feature automatically computes the relative accuracy
between control points. This is accomplished by holding one of the control points
fixed in the minimally constrained adjustment and comparing the adjusted
position of the other control points to the known control position. The difference
between the positions is computed and presented along with the relative
accuracy, based on the distance between the control points tested. A test then
compares the user-entered relative accuracy specification to the computed
relative accuracy for each pair of control points.

• If the QA test passes, the computed relative accuracy of the tested control
point pair meets or exceeds the relative accuracy specification. This is an
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indication that holding this pair of control points fixed will not degrade the
relative accuracy of the network below the required relative accuracy for
the survey.

• If the QA test fails, the computed relative accuracy of the control point pair
is of lower accuracy than the relative accuracy specification. Holding these
two control points fixed in an adjustment will cause a degradation of the
network accuracy below the required accuracy specification. In such a
case, the control points should be examined in detail to determine if a
blunder occurred during entry of the control values. If no blunder is found,
a decision must be made to determine if these points should be held fixed
in the final constrained adjustment, i.e., do not hold the problem control
points fixed in the final adjustment, or hold them fixed despite their relative
accuracy. This is normally a decision made by the final recipient of the
adjusted network, i.e. the client.

Note that the control tie analysis is only valid on adjustments that are free of blunders. If blunders
exist in the data set, the results of the adjustment do not represent the true relationship between the
control points, and therefore, cannot be used in an analysis of the control.

Quality Analysis Tools

The quality analysis tools in the adjustment module are designed to assist you in
determining the overall quality of an adjustment. The tools assist in qualifying the
attained accuracy of the survey network. Each tool is described in detail below.

Relative Error
The main purposes for performing a least-squares adjustment are: 1) locate
blunders in the data set, 2) compute the best position for all points in the survey,
and 3) determine the accuracy of the newly established points. Relative error is
one of the components used in determining the survey's positioning accuracy.

Relative error supplies an estimate to the uncertainty in the relative position of two
adjusted points (site pairs) both in horizontal and vertical position. The vertical
relative error of a site pair is one-dimensional, therefore it is represented by one
number. The horizontal relative error of a site pair is two-dimensional, and is
represented by two numbers which define a region in the horizontal plane.

Examining relative error between points gives you an indication as to the level of
uncertainty in the relationship between the two points estimated by the
adjustment. The adjustment module computes and presents the relative error
between all site pairs linked together by a direct observation (GPS vector).
Examine the horizontal and vertical relative errors. Look at their magnitudes and
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especially compare relative error values for site pairs which have similar distances
between them. Site pairs with similar distances should have similar relative errors.
If one site pair has a relative error significantly larger than others, this may
indicate a problem with an observation of these points, or a lack of sufficient data
to reliably position one of the points.

Relative Accuracy
The most common method of specifying the accuracy of a survey is in relative
terms. For example, if the accuracy specification for a survey is 1:100,000 or
0.01m + 10ppm, this is a relative accuracy specification. It is classified as relative
because it is distance-dependent. The relative accuracy specification refers to the
relative accuracy between newly established points. If the relative accuracies
between all point pairs (site pairs) are found to be 1:100,000 or better, the entire
survey is said to meet the 1:100,000 accuracy specification.

To assist in determining the achieved relative accuracy of a survey, the
adjustment module computes and presents the relative accuracy between all site
pairs linked together by a direct observation (GPS vector). Compare each relative
accuracy value to the relative accuracy specification of the survey:

• If all site pairs have a relative accuracy that exceeds that of the
specification, the survey meets the required accuracy.

• If any site pair has a relative accuracy below the required accuracy
specification, the observation between the site pair needs to be examined
to determine if anything can be done to improve the relative accuracy. If
needed, more observations may need to be collected to get the relative
accuracy of the site pair achieve the required accuracy specification.

When analyzing the relative accuracy between site pairs, it is important to keep in
mind the measurement capabilities of the equipment being used. This is
especially important for equipment that has a measurement specification that
includes a base error. GPS equipment falls into this category. On very short
baselines, the base error may limit the attainable relative accuracy. The following
example will illustrate this issue.

Assume that the measurement accuracy for a GPS system is specified as
(0.010m+2ppm. The base error here is 0.010m. This means that you can expect
to see an error of at least 0.010m on all measurements. The 2ppm (1:500,000)
part of the specification is distance-dependent. The longer the length of the
measurement, the greater the error. Using this specification, the expected error
on a 10-kilometer observation would be 0.010m+(2ppm of 10,000 meters). This
results in an expected error of 0.010m+0.020m for a total of 0.030m. An error of
0.030m on a 10-kilometer observation gives a relative accuracy of 1:333,333. If in
this example the required relative accuracy of the measurement was 1:100,000
there is no problem.
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Now assume a shorter measurement length. Using the same measurement
accuracy of (0.010m+2ppm, let's look at a much shorter measurement. On a
1-kilometer observation, the expected error would be 0.010m+(2ppm of 1,000
meters). This results in an expected error of 0.010m+0.002m for a total of 0.012m.
An error of 0.012m on a 1-kilometer observation gives a relative accuracy of
1:83,333. If, in this example, the required relative accuracy of the measurement
were 1:100,000, the required accuracy was not met with this observation. Yet, the
observation meets the measurement accuracy of the equipment. Nothing can be
done to improve these results.

This example shows the problem encountered when working with relative
accuracy specifications using only a relative term. All required accuracy
specifications should include a base component. In the example above, if the
required relative accuracy specification for the survey were changed from
1:100,000 to 0.010m+1:100,000, the 1-kilometer observation would have met the
accuracy specification. The allowable error would have increased to 0.020m on a
1-kilometer observation using this new specification.

Site Pair QA Test
Site pairs are used to determine the relative accuracy of a survey. The relative
accuracy is computed between each site pair linked together by a direct
observation (GPS vector). The relative accuracy for each site pair is compared to
the desired relative accuracy specification for the survey. If all site pair relative
accuracies are better than the required accuracy, the survey is said to meet the
accuracy specification.

The program lets you enter the desired relative accuracy specification for a
survey. From this relative accuracy specification, a maximum allowable error is
computed for each site pair based on the distance between the two sites. This
maximum allowable error is then compared to the relative error computed for the
site pair. If the relative error is smaller than the allowable error, the site pair meets
the relative accuracy specification of the survey.

The program automatically tests each site pair to determine if the relative
accuracy of the site pair meets the required relative accuracy of the survey. This
test is termed the Site Pair QA test.

• If the test passes, the relative accuracy of the site pair tested meets or
exceeds the relative accuracy specification of the survey. If all site pairs
pass the test, then the entire survey can be said to meet the required
relative accuracy specification.

• If the test fails, the relative accuracy of the site pair tested does not meet
the relative accuracy specification of the survey. The observation between
the site pair needs to be examined to determine if anything can be done to
improve the relative accuracy. If needed, more observations may be
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required to bring the relative accuracy of the site pair up to the required
accuracy specification.

Uncertainties
One of the products of a least-squares adjustment is an estimation of the error
associated with each adjusted observation (GPS vector) and each adjusted
parameter (GPS points). These uncertainties can be examined to determine the
quality of the final adjustment, and also to indicate problem areas in the
adjustment.

The program computes and displays uncertainties for all adjusted observations
and parameters. These uncertainties can be presented at two confidence levels,
standard error and 95% error. Standard error defines an error region within which
there is a 68% chance that the true value of the observation or parameter lies.
95% error defines an error region within which there is a 95% chance that the true
value of the observation or parameter lies. The uncertainties are presented in
both the horizontal and vertical frames of reference.

As part of the quality analysis of an adjustment, the uncertainties for adjusted
vectors and points should be examined. Vectors of similar length should have
similar uncertainties; points resulting from vectors of similar lengths should have
similar uncertainties. Any vector or point having uncertainties that seem too large
should be examined closely to determine the cause.

There is a move in industry circles to do away with relative accuracy
specifications and adopt absolute accuracy specifications. The absolute accuracy
specifications will define an allowable error for adjusted points vs. relative
accuracy specifications which define an allowable error between points. To
determine the absolute accuracy for adjusted points, the uncertainties for these
points would be used. If the point uncertainties are smaller than the absolute
accuracy specification, then the points and the survey meet the specification. If
any point uncertainties are greater than the absolute accuracy specification, then
the point and vectors leading to the point need to be examined to determine if
anything can be done to lower the uncertainties. In may cases, this may require
additional observations to the point.
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baseline processing, 40
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